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Service and Support

To receive support and service information for INSITE™ QST30
G-Drive and other Cummins electronic tools, contact 812-377-
8136,

Before You Call

Before you place a support call, you may be able to troubleshoot
the problem yourself by trying these steps:

1. Make sure you are not trying to run INSITE™ QST30
G-Drive on a network.

2. Run the ScanDisk command to perform routine maintenance
and repair functions on your hard disk.

3. Tum OFF your computer and then turn it ON again.
4. Start INSITE™ QST30 G-Drive and try the function again.

If the problem persists, gather the following information to
discuss with your Cummins support representative:

¢ The exact wording of any error messages that display.

e  What you were doing when the problem occurred.

Remote Control Service

We can establish remote contro! sessions to assist you online
with any problems you encounter. For information about setting
up remote control service at your facility, call 812-377-8136.




"INSITE™ QST30 G-Drive V1.0 SOFTWARE LICENSE AGREEMENT

This Agreement is referred to by the notice on the set of INSITE™
diskettes accompanying this manual. By breaking the seal on the set of
INSITE™ diskettes, you indicate your acceptance of the terms of this
Agreement. i you do not accept the terms of this Agreement, you may
return within 30 days of your purchase the entire contents of this kit to
the Cummins distributor from which it was purchased for a complete
refund. No copies of this program or its information — in any medium,
disk or hard drive — in whole or in part or imbedded in other programs
may be made prior to such retum.

RECITALS:

WHEREAS, Cummins has developed certain computer programs,
related tables and subfiles, and will be developing periodic updates
thereto, for use in diagnosing, repairing, maintaining, and programming
QST30 G-Drive electronic control modules (hereinafter, ECM) of
engines manufactured or sold by Cummins, (“Licensed Software”} (the
Licensed Software often is referred to as the "INSITE™ software™); and

WHEREAS, Cummins and Licensee desire to establish a relationship
pursuant to which Licensee will obtain certain rights from Cumming with
respect to the Licensed Software, and Cummins will provide certain
information and updates to Licensee, all for the mutual benefit of
Cummins and Licensee;

THEREFORE, in consideration of the above premises and the mutual
covenants contained herein, Cummins and Licensee agree as follows:

1. License Grant and Restrictions

a. Cummins hereby grants to Licensee a non-exclusive, non-
transferable and non-sublicensable license to use the Licensed
Software to program electronic control medules for the purpose of
recalibrating, maintaining and/or repairing of engines manufactured or
sold by Cummins. Each copy of the Licensed Scftware is specificaily
licensed for use in a single facility of Licensee for its intended purpose,
and it may not be sublicensed, sold, or otherwise distributed. The
license for Licensed Software is subject to the terms and conditicns set
forth herein.

b. Licensee may lcad each copy of the Licensed Software and the
“Security Key” files provided by Cummins onto a single computer as
required to use the Licensed Software for its intended purpose.
Licensee may also install the Licensed Software minus the Security Key
files on additional computers for use in the same facility of the Licensee
for reference purposes. Licensee may make a single backup or archival
copy of the Licensed Software other than the Security Key Disketie,
provided that Licensee affixes to the backup or archival copy any
copyright and trademark notice, serial number and any other legend of
ownership contained on the original disk from which the archival copy
was made.

¢. Licensee agrees to use the Licensed Software, and any updates to
the Licensed Software, in strict accordance with Cummins’ published
service practices and/or product warranty guidelines for the sole
purpose of diagnosing and programming electronic contral modules for
engines manufactured or sold by Cummins.

d. Licensee acknowledges that Cummins may, at its option and at no
cost to the Licenses, provide updates to the Licensed Software so that
the most current version of the Licensed Software is used to diagnose
and program the electronic control modules of Cummins engines.
Licensee agrees to, in a timely manner, make these updates to the




Licensed Software by diskettes provided by Cummins so that engine
diagnosis and programming uses the most current Licensed Software
provided by Cummins. Cummins may also offer for sale upgrades of the
Licensed Software which the Licensee is under no obligation to
purchase.

e. Allrights relating to the Licensed Software not specifically granted
to Licensee pursuant to this Agreement shall be retained by Cummins.

f. Licensee acknowledges that the Licensed Software may include
software that Cummins has obtained or licensed from a third party, and
Licensee agrees that the terms and conditions of this Agreement shall
be applicable to any such third party software. Licensee agrees to
abide by any additional or modified terms and conditions with respect to
such third party software if reasonably requested in writing by Cummins
and/or the third party,

g. It is understood by the Licensee that the Licensed Software cannot
be used to communicate with a Cummins ECM until a registry
password is obtained and entered into the program. To obtain a registry
passwaord, the Licensee agrees to provide the Licensee's name,
company name, address, and telaphone number along with the serial
number of the Licensed Software to a Cummins Distributor for purposes
of recording such information in a Software User Registry. Upon
registration of the software by the Licensee, Cummins will provide a
password that will enable the Licensed Software to communicate with a
Cummins electronic control module. It is understood by the Licensee
that the Licensed Software records its software serial number to the
engine’s electronic control module whenever the Licensed Software is
used o change values in the engine control module. Cummins
maintains this Software User Registry for purposes of identification and
traceability from the engine control module audits. The registry may be
utilized to determine, for example, that unauthorized adjustments,
maintenance, or repair of engines using the Licensed Software are
being performed contrary to the purposes of this Agreement,

2. Markings

Licensee shall use its best efforts to preserve all copyright, trademark,
ownership or other notices, legends or markings on the Licensed

Software as originally provided by Gummins. In the event the Licensed
Software contains any copyright or other message imbedded therein,
Licensee shall not modify or remove such embedded message. All
copyright, trademark, ownership or other notices, legends or markings
on the Licensed Software as originally provided by Cummins also shall
be clearly displayed on each backup or archival copy of the Licensed
Software.

3. Materals

The INSITE™ QST30 G-Drive 1.0 Installation Diskettes, Security Key
Diskettes, and User Manual constitute the entire product referred to,
herein, as the Licensed Software unless otherwise agreed to by the
parties.

4, Title

Title and full ownership rights to the Licensed Software and any
updates thereto, including all copyright rights therein, shall remain with
Cummins and/or its subsidiaries. Cummins expressly retains all rights
that it may have under US or foreign laws or international treaties
relating to the Licensed Software, except for those rights expressly
granted to Licensee herein.




5. Licensee Expenses

Costs and expenses incurred by Licensee relating to any use of the
Licensed Software, or any other costs not specifically agreed upon by
the parties in writing, shall be the responsibility of Licensee.

6. Payment

The Sales Price does not include any federal, state, local or other
governmental taxes, excise taxes, or other tariffs which may be
imposed on the sale, transportation, production, storage, or export of
the Licensed Software. Any and all such taxes and costs shall be paid
by Licensee and Cummins shall have no liability therefor.

7. Updates and Maintenance

a. Cummins agrees to provide free Help Desk suppart for the current
varsion and the latest prior version of software.

b. Inthe event of an error or defect in the Licensed Software or
periodic update thereto, Licensee shall, pramptly upon discovery
thereof, notity Cummins, in writing, of any errors or defects in the
Licensed Software and/or periodic update thereto. Cummins shall use
its best efforts to remedy or repair, at its option, such errors or defects
as it deems necessary, devoting reasonable resourcas to such task in
view of the particular business situation and customer need. Cummins
will ship software upgrades to the attention of the registered Licensee
at the shipping address entered in the registration system.

8. No Modification by Licensee

Licensee agrees not to translate, reverse assemble, reverse compile,
adapt, translate, alter, modify or change in any way the Licensed
Software, or any update thereto, without the prior express written
authorization of Cummins.

9. Warranties

Cummins warrants that the diskette containing the Licensed Seftware
shall be free from defects in material or workmanship for a period of
ninety (80) days from the date of delivery to Licenses. Cummins ailso
warranis that the Licensed Software shall be delivered free of any
rightful claim of infringement of any copyright, trademark, trade secret
or other proprietary right of any third party. In the event of a claimed

breach of this Warranty, Cummins will, at its option, procure for the
Licensee the right to continue to use the Licensed Software, modify the
Licensed Software so that it retains its functionality but without the
alleged infringement, or refund the purchase price to the Licensee and
the Licensea shall return the Licensed Software to Cummins.

10. Warranty Disclaimer

The Licensed Software and any and all updates thereto are licensed
“As Is" with the exception of the express warranties specifically provided
herein. Cumrins does not claim and does not warrant that the
Licensed Software will run error free. WITH THE EXCEPTION OF THE
EXPRESS WARRANTIES PROVIDED HEREIN, CUMMINS
DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED,
REGARDING THE LICENSED SOFTWARE, ITS MERCHANTABILITY
OR ITS FITNESS FOR ANY PARTICULAR PURPQOSE, AND CUMMINS
WILL NOT UNDER ANY CIRCUMSTANCES BE LIABLE FOR
INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES
RESULTING FROM LICENSEE’S LISE OF THE LICENSED
SOFTWARE OR FOR ANY ERROR OR DEFECT IN THE LICENSED
SOFTWARE. CUMMINS’ NET LIABILITY TO LICENSEE SHALL NOT
EXCEED THE TOTAL AGGREGATE PAYMENTS BY LICENSEE TO
CUMMINS WITH RESPECT TO THE LICENSED SOFTWARE.




The express warranties contained herein exclusively set out Cummins’
Liability to Licensee, and Licensee’s sole remedies.

11. Government Licensee

If Licensee is acquiring the Licensed Software as, or on behalf of, a unit
of the Unitad States Government, the following provisions shall be
applicable:

The Government acknowledges and agrees that the Licensed Scftware
and documentation relating thereto were developed at private expense
and no part of the Licensed Software or documentation relating thereto
is in the public domain.

The Government acknowledges Cummins Engine Company's
representation that the Licensed Software is “Restricted Computer
Software” as that term is defined in Clause 52.227-1% of the
Department of Federal Acquisition Regulation Supplement (DFARS).
The Government agrees that:

(i) if the Licensed Software is supplied to the Department of Defense
{DoD), the Licensed Software is classified as “Commercial Computer
Software” and the Government is acquiring only “restricted rights” in the
Licensed Software and documentation relating thereto as that term is
defined in Clause 252.227-7013(c)(1} of the DFARS, and

(ii} if the Licensed Software is supplied to any unit or agency of the
United States Government other than the Department of Defense, the
Government’s rights in the Licensed Software and documentation
relating thereto will be defined in Clause 52.227-19(c)(2) of the Federal
Acguisition Regulation (FAR).

12. Restricted Rights Legend

Use, duplication, or disclosure by the Government is subject to
restrictions set forth in subparagraph (¢)(1)(ii) of the Rights in Technical
Data and Computer Software clause at DFARS 252.227-7013,
Cummins Engine Company, P.O. Box 3005, Columbus, IN 47202,

13. Cenfidentiality

a. Licensee hereby acknowledges that the Licensed Software and
periodic updates thersto contain valuable information belonging to

Cummins that Cummins considers “confidential.” Consistent with the
purpose of this Agreement, Licensee agress to use its best efforts not
to release, disclose or otherwise permit unauthorized access to such
confidential information.

b. Cummins and Licensee agree to clearly mark written materials as
“confidential” if they are to be treated as confidential. Verbal
communications that are confidential in nature will be identified as so
before, during, or immediately after the communication.

¢. Licensee will use its best efforts to ensure that all individuals who
are provided access to the Licensed Software under this Agreement will
observe and perform this nondisclosure covenant.

14. Termination of Agreement

a. Cummins may terminate this agreement for cause, including, but
not limited to, adjustments, maintenance, programming, or repair, of
Cummins engines when not authorized by the owner of such engines.
b. Inthe event of termination of this Agreement, all rights granted by
this Agreement shall revert to Cummins. Upon termination of this
Agreement, Licensee will deliver to Cummins all material furished by
Cummins pertaining to the Licensed Software and will also warrant that
all copies thereof have been returned to Cummins or destroyed,




¢. Inthe event of termination of this Agreement, Licensee and
Cummins shall remain obligated with respect to the provisions of this
Agreement relating to limitation of warranties and confidentiality of
information.

15. Completeness

Licensee and Cummins agree that this Agreement constitutes the
complete agreement and understanding between the parties relating to
Licensed Software and updates thereto. This Agreement supersedes all
prior agreements, understandings, and negotiations whether written or
verbal with respect to the subject matter hereof. This Agreement can
only be modified by a written agreement signed by both parties.

16. Notices

Any questions concerning this Agreement, any inquiries related to the
Licensed Software, and any notices to Cummins pursuant to this
Agreement should be directed to Cummins Electronic Tools and
Services Help Desk, MC 41317, Cummins Service Products, 1460
National Road, Columbus, IN 47201, 812 377-8136. Notices to
Licensee shall be at the address specified an the first page of this
Agreement to the attention of the person who signed this Agreement on
behalf of Licensee. Either party may direct that notices be sent to a
different person and/or address by so requesting in writing to the other
party.

17. Export Regulations

Licensee understands that the Export Administration Regulations of the
Department of Commerce of the United States may prohibit the export
of the Licensed Software to certain countries and agrees to conform to
those regulations. Licensee also agrees to conform to these
regulations. Licensee shall indemnify Cummins against any loss or
expense related to Licensee’s failure to conform to those regulations.

18, Governing Law

This Agreement shall be govemned by and construed in accordance with
the laws of the State of indiana.

19. Atiorneys’ Fees

In the event of any legal action or other proceeding that is brought
about to enforce this Agreement, the prevailing or successful party shall
be entitled to recover reasonable attorneys’ fees as well as other costs
incurred in that action or proceeding in addition to pay compensation to
which it may be entitied as a result.

20. Agreement Successors and Assigns

The terms and conditions of this Agresment shall inure {o the benefit of
and be enforceable by Cummins and the successors and assigns of
Cumming’ interest in this Agreement and/or Cummins' ownership of the
Licensed Software.

Revised: September 6, 1996




This manual uses the term
“mouse” to refer to any
Windows® compatible
pointing device,

About This Manual

The INSITE™ QST30 G-Drive User's Manual is for mechanics
who use the INSITE™ QST30 G-Drive software to troubleshoot
and maintain Cummins QST30 G-Drive electronic engine
modules. This manual assumes that you have a working
knowledge of Windows® 95 and that you have a mouse or other
Windows® compatible pointing device.

You should be able to use a mouse to:

* Open an icon into a window

» Make a window active

® Close, maximize, and minimize a window

# Select an entry by highlighting it or checking a box, or by
turning a radio button on or off

For more information about working with Windows® 95, refer to
the following source:

e  Fasy Windows 95, published by Que® Corporation and
available at most major bookstores.

The INSITE™ QST30 G-Drive User's Manual has four sections:

e Section 1, Working with INSITE™, presents the basic

concepts and procedures you need to know to use INSITE™
QST30 G-Drive.

Section 2, Menus and Commands, describes each of the
menus, commands, dialog boxes, and fields in INSITE™
QST30 G-Drive, in order by menu. This section serves as a
quick reference for finding more information about a specific
function.

Section 3, Menu Maps, illustrates the path you take to get to
each of the dialog boxes in INSITE™ QST30 G-Drive.

Section 4, Referaence Information, contains information about
troubleshooting communications messages that display in
INSITE™ QST30 G-Drive, and also contains a Glossary of
terms.

When using INSITE™ QST30 G-Drive for the first time, be sure
to read Section 1, Working with INSITE™. After learning how to
use INSITE™, refer to Sections 2, 3, and 4, as needed, for further
information about INSITE™ QST30 G-Drive.

Also, refer to the Help system within INSITE™ QST30 G-Drive. It
contains most of the same information as this manual, in a
format that you can quickly access on your computer.

For information about system administration functions, refer to
the INSITE™ System Adminisirator's Guide.
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Working with INSITE™

What INSITE™ QST30 G-Drive Does

INSITE™ QST30 G-Drive is a Windows® 95 software application
that works with Cummins electronic control modules (ECMs) to
diagnose and troubleshoot engine problems, and modify an
engine’'s operating settings. The INSITE™ QST30

G-Drive software works with all QST30 G-Drive ECM part
numbers.

You use INSITE™ QST30 G-Drive on an IBM-compatible
personal computer (PC), often a laptop computer, that is
attached to an ECM with a serial interconnect cable. When a PC
is attached to an engine, you can retrieve the latest information
about that engine. You can also analyze ECM data to monitor
and assess the operation of your engines.

Hooking Up to an Engine

To gather the latest information about an engine, attach your PC
to a QST30 G-Drive ECM using a serial interconnect cable,
Cummins Part No. 3825183. After the PC is attached to an ECM,
use the INSITE™ QST30 G-Drive software to read data from the
ECM or to change settings in the ECM.

When the PC Must Be Attached to an Engine
A PC must be attached to an ECM to:
« Set operating parameters for the engine.
* Read the most recent fault data for the engine.
¢ Clear fault data for the engina.
Monitor and test a running engine.

INSITE™ QST30 G-Drive User's Manual Working with INSITE™ « 1




When the PC Does Not Need to be Attached to an
Engine

. A PC does not need to be aftached to an engine to:

» LUse INSITE™ QST30 G-Drive in Simulator mode. See User
Options on page 48 for more information.

Use the Help system or read the online Fault Information
System manual.

Move or Install a security key.

To connect a standard PC to an ECM

1. Use serial interconnect cable, Part No. 3825183.

2. Connect the serial connector to the serial port on the back of
your PC.

3. Connect the 9-pin Deutsch connector to the engine harness.

Note: The 9-pin Deulsch coninector on the engine harness is
located near the flywheel housing.

To connect an NGT computer to an ECM

Hookup procedures for NGT computers are the same as for
standard computers. UUse serial interconnect cable, Part No.
3825183, to connect the ECM to the NGT serial port.

INSITE™ QST30 G-Drive Basics

If you have previously
installed other INSITE™
products, your existing icons
will be unchanged. You can
access all existing INSTTE™
products from your current
icons.

During installation, the QST30 program folder is created inside
the Programs folder on the Start Menu.

: .
fQsTI0!
iG-Drive!

’ 8
QST30Help

1 e Il
1 ReadmeFile Uninstall
3 Q5T30

2 « Working with INSITE™

INSITE™ QST30 G-Drive User's Manual




The QST30 folder contains these icons:

» The Insite for Q3T30 G-Drive icon, which is used to access
all of the features in INSITE™ QST30 G-Drive.

The QST 30 Help icon, which is used to view the Help
system without starting INSITE™ QST30 G-Drive,

The QST 30 Read Me icon, which contains the latest
information about INSITE™ QST30 G-Drive that may not be
included in the manual.

The Uninstall QST30 icon, which enables you to remove
INSITE™ QST30 G-Drive from your system.

Opening the Insite for QST30 G-Drive Icon

Like other Windows applications, you start INSITE™ QST30
G-Drive by opening the Insite for QST30 G-Drive application
icon.

To open INSITE™ QST30 G-Drive:

_ 1. Click the Windows® 95 Start button.
2. On the Programs menu, highlight QST30.
3. On the QST30 menu, click Insite for QST30 G-Drive.

Using the Main INSITE™ QST30 G-Drive Window

You perform all functions from the main INSITE™ QST30
G-Drive window. This window, shown on the next page,
incorporates many of the standard operating techniques used in
Windows® 95.

The Title bar always displays the product name, INSITE for
QST30 G-Drive.

The Menu bar, below the Title bar, provides complete access
to every function in INSITE™ QST30 G-Drive. Click a menu
name to display menu commands. Note: You can hold the
mouse pointer over a command and press F1 on your
keyboard to display Help for the command.

The Toolbar at the left of the main window contains buttons

. that you can click to quickly access the most frequently used
commands. Note: You can hold the mouse pointer over a
bution to display the name or function of the button,

The Data Information Line (DIL) near the bottom of the
window displays reference information about the active
function. It includes a description of the current function, the
active ECM part number, and the current operation mode.

INSITE™ QST30 G-Drive User's Manual Working with INSITE™ « 3




Title bar Close button
M aximize bufton
Minimize button-..

Insite for OST30 G-Drive -

SRy

Toolbar

Information

The Main INSITE™ QST30 G-Drive Window

The Minimize and Maximize buttons at the top right corner
are used to convert the window to a button on the Windows®
95 taskbar or to expand the window to the full size of your
screen.

‘The Close button at the top right corner is used to close a
window. You can alsgo use this button to exit INSITE™ QST30
G-Drive.

Getting Help

You can get information about every feature and function in
INSITE™ QST30 G-Drive by using the Help system. You can get
help in one of these ways:

Click a command on the Help menu.

Click the Help button on the Toclbar or in a dialog hox.

Press the F1 key on your keyboard. You can use this in any
dialog box, and also whenever the mouse peinter is over a
command on the Menu bar's pulldown menus.

The Help system contains most of the same information as the
INSITE™ QST30 G-Drive User's Manual in a format that is easy
to aceess on your computer.

4 » Working with INSITE™ INSITE™ QST230 G-Drive User's Manual




Printing Help Topics
You can print any Help topic that appears in the Help system.

To print 2 Help topic:

+ Click inside any Help window using the right mouse button,
then select Print Topic, or

Click the Print button on the button bar, if the button is
present, or

Click the Options button on the button bar, if the button is
present, then select Print Topic.

Using Menus to Select Commands

INSITE™ QST30 G-Drive uses standard Windows® 95
procedures for selecting commands on a menu.

To select a command on a menu:

1. Click once on the menu name to display a pulldown menu with
a list of commands. You can also hold down the ALT key while
typing the underlined letter in the menu name. For example,
type ALT + A to display the Adjustments menu.

2. Select a command on the menu by clicking it or by typing the
underlined letter in the command name. The corresponding
dialog box or submenu displays. For example, type r on the
Job menu to display the Print Setup dialog box.

Using the Toolbar to Select Commands

You can use the Toolbar at the ieft of the main INSITE™ QST30
G-Drive window as an alternate way to view fault information,
monitor and/or log a running engine, exit INSITE™ QST30
G-Drive, or view Help information.

To select a command on the Toolbar:
+« Click once on a button.

The corresponding dialog box displays, just as if you had
selected the command on a menu.

INSITE™ QST30 G-Drive User's Manual Working with INSITE™ ¢ 5




Exiting INSITE™ QST30 G-Drive

You use standard Windows® 85 procedures to exit the program.

To exit INSITE™ QST30 G-Drive:

+ Click the Close button at the top right corner of the main
INSITE™ QST30 G-Drive window, or

Click Exit on the Job menu, or
Click the Exit button on the Toolbar.

Entering and Viewing Data

All data is viewed and entered in dialog boxes. You display dialog
boxes by choosing commands on the menus or by clicking a
button on the toolbar. This section describes the types of data
used in INSITE™ QST30 G-Drive and the common techniques
used for entering and viewing data in dialog boxes.

Becoming Familiar with Common Buttons

The following buttons display near the bottom or on the right side
of dialog boxes:

The ECM Save button saves all data in a dialog box to the
ECM.

The Close button closes dialog boxes that contain read-only
data.

The Caneel button closes a dialog box, usually without
saving any changes made during the active session. In some
dialog boxes, though, you must click Cancel to close the
dialog box after clicking ECM Save.

The Help button displays help information for the active
dialog box or window.

The Keyboard button enables you to use a mouse to click
the keys of an on-screen keyboard. This is useful if you do

not have access to a keyboard and want to use the mouse

exclusively to enter data.

The Print button enables you to print the contents of a
dialog box.

Other buttons are also available, depending on the dialog box.
The uses of other buttons is explained in their corresponding
menu and command sections.
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Using Common Data Entry Techniques

There are several data entry techniques that are commonly used
in INSITE™ QST30 G-Drive:

+ Type data by positioning the cursor inside the data entry box
and typing keys on your keyboard.

Type data by clicking inside the data entry box, and then
clicking the Keyboard button. Then use the mouse to click
the keys of the on-screen keyboard.

Select a number in a spin box by clicking the up or down
arrows until the number that you want displays. You can also
type data directly into the data entry area of the spin box.

Click a Drop down list button to display a list of entries,
then highlight an entry in the list with the mouse to select it.

Click in a check box to tumn it ON or OFF (enable or disable
it); 2 check mark displays in the check box when it is ON.
You can click as many check boxes as you want in a list of
options.

Click a radio button to turn it ON or OFF. A radio button is
filled in with a dark circle when it is ON. Radio buttons are
mutually exclusive in a list; you can select only one.

Responding to Messages

When working with INSITE™ QST30 G-Drive you may be
prompted with a message that provides you with additional
information about a function that you are performing or that alerts
you to a possible problem. Most of the time you simply respond
by clicking the OK button.

For example, when making a change to the ECM, a verification
message such as this displays:

Do you want to modify the ECM?

You can click the OK button to go ahead and modify the ECM or
click the Cance! button to return to the previous dialog box
without modifying the ECM.

In the case of an error message, a short description of the error
displays. For example:

ECM not responding.

In this case, you c¢an click the OK button to return to the previous
dialog box and try again.
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When Data or Commands Are Disabled

As you work with INSITE™ QST30 G-Drive you will notice that
data and commands are sometimes disabled (displayed in gray,
or grayed-out). When data displays grayed-out it can only be
viewed, it cannot be changed. When a command on a menu
displays grayed-out, it cannot be accessed.

There is only one reason for this to happen in INSITE™ QST30
G-Drive:
* The proper type of data is not active to perform the function.

Note: Somelimes when a field is grayed-out, you can hold the
mouse pointer over the grayed out field and an explanation
displays in the Data Information Line at the boftom of the main
window.

Menu Descriptions

This section briefly describes when you would use each menu in
INSITE™ QST30 G-Drive. For more detailed information about
each menu command, see the appropriate command heading in
the Menus and Commands section of this manual.

Job Menu

Use commands on the Job menu {o setup your printer for use
with INSITE™ QST30 G-Drive, and to exit the program.

Connect to ECM

Use the Connect to ECM menu (or the Connect button on the
toolbar) to open communications with an ECM.

Adjustments Menu

Use the Features and Parameters command on the Adjustments
menu to set the operating parameters, or values, of various
adjustable items related to engine operation. You must be
attached to an ECM, or in Simulator mode, to view the latest
operating parameters or to change operating parameters for an
engine.

View Menu

Use the Fault Information command on the View menu to review
fault information and snapshot data.
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Tests Menu

Use commands on the Test menu to perform diagnostic tests on
an engine. You must be attached to an ECM or in Simulator
mode to perform any of these tests.

Tools Menu

Use commands on the Tools menu to control an engine with your
PC, perform ECM meter calibrations, monitor a running engine,
log data from an ECM to & file, and reset the ECM. You must be
attached to an ECM or in Simulator mode to perform any of these
functions.

System Menu

Use commands on the System menu to set user options for
working with INSITE™ QST30 G-Drive, and to install, move, or
view security information.

Help Menu

Use commands on the Help menu to find information about how
to use INSITE™ QST30 G-Drive, learn how to use help, and
display service and support information.

Setting Options

You can set several options for working with INSITE™ QST30
G-Drive including:

» COM port settings.
e Using Simulator mode.
s  The units of measure used for temperature and pressure.

Setting the COM Port

Use the User Options command on the System menu to select
the COM port on your PC to use to communicate with the ECM.

If you are not attached to an ECM and want to use INSITE™
QST30 G-Drive in Simulator mode, you can specify Sim R or Sim
S in the Port Setup dialog box. If you do not specify a Simulator
mode, most of INSITE™ QST30 G-Drive’s features will be
disabled, or grayed-out.

Specifying Units of Measure

Use the Units of Measure command on the System menu to
select a set of unit measurements for coolant temperature and oil
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pressure. For example, select US to use all of the relevant unit
measurements for the United States.
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Menus and Commands

Use the Job menu to setup your printer and to exit INSITE™
QST30 G-Drive.

Job Menu

Each command on the Job menu is described in the following
sections.

Print Setup

Use the Print Setup command on the Job menu to change the
default printer used to print information from INSITE™ QST30
G-Drive. You can use the Print Setup command to select a
default printer for INSITE™ QST30 G-Drive or a default printer to
use with all of your Windows® 85 applications.

Printer

Name: Specifies the printer currently selected for use. To select
another installed printer, use the drop down list box.

Status: Specifies whether the selected printer is the default
printer, and whether it is ready to print.

Type: Specifies the printer driver in use for the selected printer.
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Print Setup Dialog Box

Where: Specifies the port that the selected printer is connected
to, if applicable.

Comment: Some printers enable comments to be inserted using
their Properties dialog box(es). In most cases this field is blank.

Paper

Size: Select the size of paper you want to use for printing, All
INSITE™ reports are designed to print on 8 1/2 % 11 inch sheets.

Source: Select the paper feeding location.

Orientation

Portrait: Select this option to print sheets using a standard
vertical orientation. All INSITE™ QST30 G-Drive reports are
designed to print in portrait orientation.

Landscape: This option would enable you fo print sheets using a
horizontal orientation. INSITE™ QST30 G-Drive does not support
landscape orientation.

Buttons in Print Setup

Click the Properties button to specify additional opticns for your
printer. The available options settings vary depending on the
printer being used.

Exit

Use the Exit command on the Job menu to exit INSITE™ QST30
G-Drive.
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Adjustments Menu

Use the Adjustments menu to view and/or adjust ECM settings
of various engine operating parameters.

Adjustmen

Adjustments Menu

Before You Begin Changing ECM Parameters
Be sure to follow these steps before changing ECM parameters:

» Make sure the ECM is attached to your PC. For more
information, see Hooking Up to an Engine in the previous
chapter.

Make sure the engine is not running. INSITE™ QST30
G-Drive does not allow you to change ECM parameters while
the engine is running.

Features and Parameters

Use the Features and Parameters command on the Adjustments
menu to open the Field Parameter Editor. Use the editor to view or
edit the values for all of INSITE™ QST30 G-Drive's adjustable
parameters.

About the Adjustable [tems

You use the Field Parameter Editor dialog box to adjust or
change the values for all of INSITE™ QST30 G-Drive's
adjustable parameters. The Adjustable ltems list in the Editor
window contains parameters that affect the performance and
proper functioning of the engine.

Note: Complete definitions for all the Adjustable items are in the
Glossary on page 68. A table of Ramp Times is on page 15.

When you first open the Field Parameter Editor, current ECM
values display for the Adjustable ltems.

To change a parameter setting:

1. Double click a parameter in the list of Adjustable ltems, or
highlight one with the mouse and then click the Edit button.
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edd Parameter Lditor

Barber Colman Scale Factar
Cauolant Temp \varning Threshold
Engne Qffset Time

Covernor Droop

Soverngr s Adinst

ldie Speed

Meter Caglant Terng Max Duty Cyele
Meter Engine RPM Max Guty Cycle
Meter Madmum Engine RFM
Meter Maxdmum Ol Pressure
Meter Maimum Temperature
Meter Minimum Engine RPM

Meter Minimum Gil Pressure

Field Parameter Editor Dialog Box

2. Edit the parameter value using either the data entry field/spin
box or the Default button. See the next section for more
information.

3. Click the Change button to change the parameter's value in
the list of Adjustable ltems.

Editing Parameter Values

When you select a parameter to edit, the parameter name
displays on the right side of the window. The current value for the
parameter displays in the spin box and the ECM default value
displays on the Default button.

Adjust the value up or down using the spin box, or type a new
value. You can aiso return to the default setting by clicking the
Default button.

When you are finished adjusting the parameter value, click the
Change button to change the parameter's value in the list of
Adjustable ltems. The new value(s) become permanent in the
ECM after you click the ECM Save button at the button of the
dialog.

Adjustment Ranges

Most of the Adjustable ltems have a range of possible values; the
parameters and their ranges are listed below. For definitions of
the Adjustable ltems, see the Glossary on page 68.

Barber Colman Scale Factor: 500 to 2000
Coolant Temp Warning Threshold: 0 to 255
Engine Offset Time: 0 to 9,899,999.9
Governor Droop: 0 to 10

Governor Gain Adjust: 0.1 to 10
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Idle Speed: 700 to 800

Meter Coolant Temp Max Duty Cycle: 0 to 100
Meter Engine RPM Max Duty Cycle: 0 to 100

Meter Maximum Engine RPM: 0 to 2400

Meter Maximum Qil Pressure: 0 to 100

Meter Maximum Temperature: 0 to 255

Meter Minimum Engine RPM: 0 tc 2400

Meter Minimum Oil Pressure: 0 to 100

Meter Minimum Temperature: 0 to 255

Meter Qil Press Max Duty Cycle: 0 to 100

Oil Press Warn Threshold at Idle: 0 to 100

0il Press Warn Threshold at Rated: 0 to 100
Overspeed Shutdown RPM: 800 to 2070

Ramp Time (Crank to Rated): O to 30 (see table below)
Ramp Time (ldie to Rated): 0 to 30 (see table below)

1500 rpm Total Ramp Time 1800 rpm Total Ramp Time

from from Crank or from from from Crank or from
700mm Idle from B0O0rpm tdle  S00rpm Idle  700pm Idle  from B0O0mpM Idle SO0 Idla

b

2sec 1 88¢C 1 zee 2 seC 2 seC 2 set
3 sec Asec 2 sac 4 sec 4 sec 4 sac
& sec 4 sec 4 8ec 7 set 6 sec Ssec
asac B sec 5 saec 9 sec Bsec 7 sec
8 sec T soc 6 sec 11 s8c 10 sec 9 se¢
10 sec 8sec 7 sec 13 sec 12 sec 11 sac
11 sec 10 sec 8soc 15 sec 14 sec 13 sec
13 sec 11 sec 10 sec 18 sec 16 sec 14 sec
14 sec 13 sec 11 sec 20 zac 18 sec 16 sec
16 s8¢ 14 sec 12 sec 22 gec 20 sec 18 sec
18 ser 15 sec 13 s8¢ 24 sec 22 sgc 20 s8¢
19 sec 17 sec 14 sec 26 sec 24 sec 22 sec
21 et 18 s8c 16 sac 29 see 28 see 23 56
22 sec 20 sac 17 sec 31 s8¢ 2B sec 25 sec
24 se8c 21 sec 18 sac 33 sec a0 sec 27 spe
26 sec 22 sec 19 sec 35 s8c 32 sec 29 sac
27 5e¢ 24 sec 20 sec 34 sec 3 sec
28 spc 25 sec 22 sec 36 sec 32 sec
30 sac 27 sec 23 sec 38 sec 34 sec
32 sec 28 sec 24 sec 40 sec 36 sec
34 sec 29 s8¢ 25 s8c 42 sec 38 gec
35 sec 31 sec 26 sec 44 sec 40 sec
37 sec 32 sec 28 et 46 se¢ 41 sec
38 sec 34 sec 25 sec 48 sec 43 sec
40 sac 356 sec 30 sec 50 sec 45 sec
42 sec 36 sec 31 sec 52 sgc 47 sec
43 sec 38 sec 32 sec 54 gec 49 sac
45 88C 38 sac 34 sec 56 sac 50 sac
46 sec 41 s8¢ 35 sec 53 sac 52 sec
48 sec 42 sec 36 sec 60 sec

43 sec 43 sec 37 sec 62 gos 56 sec

Ram
#
o
1
2
3
4
5
[
7
8
9

10
1
12
13
14
15
16
17
18
19
20

Table of Ramp Times

Torque Curve Adjustment: 0.0 to 1.0
Woodward Scale Factor: 20 to 60
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To save parameter values to a file for use in a later session:

1. Make all necessaty changes to parameters in the Adjustable
Items list.

2. Click the Set button.

3. Name this set of parameter values using the file format
anyname.fpe. It is best to use as descriptive a filename as
possible, so that the file can be easily identified later.

To use a set of user-defined parameter values from a
previous session:

1. Click the Get button.

2. Select the desired .fpe file from the list of available files. The
parameters in the Adjustable ltems [ist will acquire the values
defined in the file.

If you want to save the new parameter values in the ECM,
click the ECM Save button.

Buttons in the Field Parameter Editor

Use the EdIt button to “open” a parameter in the right side of the
window; there you can edit its value in the spin box.

Use the Change button to transfer an edited parameter value
from the spin box back to the list of Adjustable tems. If you do
not click this button the parameter value in the list remains the
same, unaffected by any changes you make in the spin box.

The Default button displays the default ECM value of the

parameter opened in the spin box for editing. Also, you can click
the Default button to automatically insert the default value in the
edit field. This is useful if you start editing a parameter value but

decide to return it to its default.

Use the ECM Save button to save all parameter values of the
Adjustable Items in the ECM. Any edited values do not change in
the ECM until you click this button.

Use the Get button to retrieve a file containing a list of specific
pre-defined parameter values. After clicking Get, the parameter
values in the file display in the Adjustable Items list.

Use the Set button to save a list of specific parameter values for
the Adjustable ltems to a file. The file is stored in the \Log
directory and uses the file extension .fpe. You can use any
descriptive name to describe the file such as anyname.fpe.

Use the Print button to print the Adjustable ltems list and the
associated parameter values,

Use the Cancel button to close the dialog box, whether or not
you saved changes to the ECM.
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View Menu

Use the View menu to display fault and snapshot information.

ke

View Menu

Fault Information

Use the Fault Information command on the View menu to display
information about an engine's fault data as well as to clear fault
data. Each fault is represented by a fault code that indicates a
particular malfunction or abnormal condition within the ECM,
subsystem, or engine.

Faults can be active or inactive. Active faults indicate that the fault
condition is present now. Inactive faults indicate a condition that
occurred since the last time fault data was cleared, however
inactive faults are not presently active.

There are several dialog boxes associated with the Fault
information command. Each of these dialog boxes is descriped in
the following sections:

The Fault Information dialog box displays a summary list of
fault data for an engine.

The Fault Information - Additional Information dialog box
allows you to select diagnostic information or more detailed
tault data for display.

The Fault Overview window provides access to the Fault
Information System and describes each fault in detail.

The Troubleshooting Steps window provides access to the
Fault Information System and describes specific actions you
can take to correct a fault.

The Snapshot dialog box displays key engine sensor data
and switch settings that were recorded at the first and last
occurrences of each fault.
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Fault Information Dialog Box

The Fault Information dialog box displays immediately after
choosing the Fault Information command. It shows a multi-
column entry for each fault generated by the engine.

Fauli Intormation

L I AT A LT T e

Fault Information Dialog Box

Current ECM Time: The cumulative ECM running time to date.

Fault Code: A numeric Cummins code that identifies the fault.
Refer to the Fault Information System for a detailed explanation
of each specific fault code.

Status: Indicates whether the fault is currently active or inactive.

Count: Indicates the number of times the fault has occurred
since the last time fault data was cleared.

Time Since Last Fault: Indicates how much ECM time has
elapsed, in hours and minutes, since the fault was |ast recorded.
For example, a value of 20:10 indicates that 20 hours and 10
minutes has elapsed, in ECM time, since the last fault of this type
occurred.

Buttons in the Fault information Dialog Box

Click the Clear button to erase all faults in the ECM. This button
is disabled when the sngine is running.

Select a fault in the Fault Information dialog box and click the
More Fault Info button to see more detailed diagnostic and

supporting information about a fault. See the following section for
more information.

Click the Print button to print a report of all fault information.
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Fauit Information - Additional Information Dialog Box
To display the Fault Information - Additional information
dialog box:

1. Inthe Fault Information dialog box, select a fault that you
want more information about.

2. Click the More Fauit Info button.

Fault Inlnrmating - Additional Information

i

Fault Information - Additional Information Dialog Box

The top section of the Fault Information - Additiona!
Information dialog box displays summary information about
the fault, including the tault code and the ECM time of the
fault.

The bottom of the dié.log box contains two categories of
buttons: Troubleshooting Information and Additional Data
from ECM.

The Troubleshooting Information buttons (Fault Overview
and Troubleshooting Steps) provide access to the online
Fault Information Systerm manual that contains detailed fault
descriptions and troubleshooting techniques.

The Additional Data From ECM button(Snapshot - Sensors
and Switches Data) provides access to sensor and switch
data associated with the fault. These buttons and their
associated diafog boxes are described in the following
sections.
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Fault Overview Window

The Fault Overview window contains an online reference
manual within INSITE™ QST30 G-Drive and is part of the Fault
Information System. Use the Fault Overview window to find
concise, yet detailed, information about any fault code in the
system.

Working Inside the Fault Information System

The Fault Information System is designed as a standard
Windows® Help system. While inside this system, you can use
conventional Windows® 95 Help techniques to display and find
information. For example:

+ Click text marked by a dotted underline to display a pop-up
window related to the text.

Click text marked by a solid underline to go to another
window related to that topic.

Click once in a pop-up window to remove it from the screen.

Use the buttons on the Button bar to perform common
Windows® 95 Help functions (Search, Back, etc.).

Use the Print Topic command on the File menu to print
information related to the current screen.

Working with Fault Overview Information

Fault overview information includes summary information about
the selected fault including the fault code, reason for the fault,
and possible effects of the fault. It also contains the SRT code for
estimating your repair time. '

From the Fault Overview window, you can display additional
information about the fault and its symptoms:

s Click the Diagram button to display a specific circuit wiring
diagram for the component that is related to this fault.

Click the Shop Talk button to display added background
information about the fault and helpful troubleshooting tips.

Click the Location text (marked by a dotted underline) for a
pop-up diagram that shows the physical location of the part
that is related to this fault.

Click the Description text (marked by a dotted underline) for
a pop-up description of the part related to this fault and the
purpose of the part.

Click the Troubleshooting Steps text (marked by a solid
underline) for a list of steps to correct this fault.

To display the Fault Overview window:

1. Click the Fault Overview button in the More Fault
Information dialog box.
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A concise overview of the selected fault displays.

BEASON - ) EFFEDT

Engine Speed Sensor (ESS) Fuel shutoff valvas are

signalon pins 21 and 22 ofthe  de-energized (valves

angine hamess ¢laclronic closed).

comrol moduta (ECM) cennactor  Comman Alorm outpul is

indieakes ergine speed grealer  energized.

than alarm (stutdown) threshold.  Overspeed relay driveris
enargized.

LOCATION
CESCRIFTION

TBOUBLEBHOOTING STEPS

Fault QOverview Window

Use the Contents, Search, Back, and Glossary buttons to
find more information about each fault and to navigate
through the online database. In addition, you can use the
Diagram and Shop Talk buttons previously described.

Also, click the Location, Description, or Troubleshoating
Steps text for more information about the fault.

Use the Annotate command on the Edit menu to enter
comments related to a fault. This allows you to personalize
the fault information for your site,

After entering a comment, a paper clip icon displays on the
screen where you entered the information. Click the paper
clip icon to display the note.

Close the Fault Overview window to return to the Fault
Information - Additional Information dialog box.

Troubleshooting Steps Window

The Troubleshooting Steps window contains an online
reference manual within INSITE™ QST30 G-Drive and is pan of
the Fault Information System. Use this window to find concise as
well as detailed information about how to correct a fault.

Working Inside the Fault Information System

The Fault Information System is designed as a standard
Windows® Help system. Use conventional Windows® 95 Help
technigues to display and find information. For example:
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Click text marked by a dotted underline to display a pop-up
window related to the text.

Click text marked by a solid underline to go to another
window related to that topic.

Click once in a pop-up windew to remove it from the screen.

Use the buttons on the Button bar to perform common
Windows® 85 Help functions (Search, Back, etc.).

Use the Print Topic command on the File menu to print
informatien related to the current screen.

Working with Troubleshooting Information
There are three levels of diagnostic help available:

1. Troubleshooting Steps are designed for the experienced
mechanic who needs a guick cutline of the steps to take to
correct the fault. This is the first screen that dispfays when
you open the Troubleshooting Steps window.

Summary Steps are designed for the mechanic who wants a
more detailed overview of the major troubleshooting steps,
as needed, to correct the fault. A summary topic includes the
step description, a diagram, and specifications related to that
step. lt also provides some guidelines for taking actions to
correct the fauit.

Guided Steps are designed for mechanics who want the
most detailed information about each step in the
troubleshoating process. Guided steps provide & step-by-
step path through the troubleshooting process. Ciick an OK
icon to proceed to the next step or click the Not OK icon to
receive summary information on how to correct the problem
before proceeding.

Each of these uses is illustrated later in this section.

The Troubleshooting Steps window contains the following
buttons that provide quick aceess to other related information
about the fault and its symptoms: .

» (Click the Diagram button to display a circuit wiring diagram
for the component that is related to this fault.

Click the Shop Talk button to display added background
information about the fault and helpful troubleshooting tips.

Click the Conditions button to display a list of pre-testing
conhditions or setup requirements that you musi follow to get
the best possible outcome from the troubleshooting steps.

Click the Location text (which is marked by a dotted
underiine) for a pop-up diagram that shows the physical
location of the part that is related to this fault.
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Click the Description text (which is marked by a dotted
underline)} for a pop-up description of the part related to this
fault and the purpose of the part.

Click the Overview text (marked by a solid underline) for
descriptive information about this fault.

To display troubleshooting steps:

1. Click the Troubleshooting Steps button in the More Fault
Information dialog box.

FAULT CODE 224
TROUBLESHOGTING STEPS

SRECIFICATION

STEP 1; Kantily the reason for the

overspeed.
STEP 14; Chack for Fault Code 171, Faull Gode 171 not present
STEP 1B: Check for moloring of Engine not reverse
BNGine (reverse power). powered
STER 1C: Check for altemate fuel Mo alternate fuel source
SOUTCe.
STEP 1D0: Check engine rpm wih Gorract ;pm reading
saefvice tool menor.

STEP 2: Claar fault codes,
£2 20 Disabla the fault cods, Fauit Code 234 inactive
STEP 28: Cloar \he nactive faul All fauks clearad
codaes.

LOCATION
CESCRIPTION

OVERYIEW

Troubleshooting Steps Window

A summary list of troubleshooting steps displays in outline
format. For example, Step 1, Step 1A, Step 1B, Step 2, Step
2A, Step 2B, and so on.

WARNING! Troubleshooting Any cautionary notes or wamings associated with the steps
may present hazards that can display in a pop-up box. Click anywhere outside these boxes
result in severe personal to remove them from the screen and resume viewing the
injury or death. Before window. To display them at any time, click the Caution or

performing any Warning icon.
troubleshooting steps, see 9

impartant safety instructions . Use the Contents, Search, Back, and Glossary buttons to find

in the Service Manual. more information about a fault and to navigate through the
online database. In addition, you can use the Diagram, Shop
Talk, and Conditions buttons previously described.

Also, click the Location, Description, or Overview text for
more information about the fault.

Close the Troubleshooting Steps window to return to the
Additional Information dialog box.
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To display summary steps:

1. From the Troubleshooting Steps window, click a major
underlined step. For example, click Step 1 (not Step 1A).

The Summary window displays. it contains diagrams and
specifications related to this step.

Not OK icon

FAULT CODE 234 STEP 1 SUNMARY

SPECIFICATION - ’ ACTION

STEP 1: Idenlify the réleen
versheed.
STEP 34 Chack for Faull Code 1717Fault Code 171 nof praseni @
Goto

Fault Cada

STEP 16 Ch P4

STEP 16 Chack for motoring of Engine not revarse

engina {raverse power). s powarad @ Golo 2
STEF 1C: Check for alemate fued No altemale iusl source @

SOWCe. Gote 2
STEF _1D: Chack enging rpm with Comact pm reading @

service 1oot monftor. Golo 2

Summary Window

The troubleshooting procedures are organized so that a
satisfactory result from each step will lead to the next step in
the procedure. For example, if Step 1A is OK, you can
immediately proceed to Step 1B. Simply click the underlined
Step number to go directly to it.

If, after performing a step, the results are not satisfactory,
click the Not OK icon in the Actions column. A pop-up
window will provide summary information on what to do to
correct the probtem.

After reviewing the information, you can click:

Summary Text to display the next summary step for this
fault.

Troubleshooting Steps to display the high-level summary of
troubleshooting steps.

To display guided steps:

1. From the Troubleshooting Steps window or Summary
window, click one of the detailed troubleshooting steps. For
example, click Step 1A (nof Step 1).

The Guided Step window displays. It contains diagnostic
information specific to this step.
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You can click any graphic icon,
like the OK icon, for additional

infannation. \

] '® Golto Steg 18, -0

STED

Check for Fault Coda 171. Fault Code 171 not prassi
+ Raad tha fautt codes using INSTTE™, Part
No. 3825145,

STER.1 SUMMARY.
TROUBLESHOOTING STEES

Guided Step Window

Any general conditions that must be met prior to performing
the sieps display in a pop-up box. Ciick anywhere onscreen
to remove them from the screen and to scroll through the
window. Display them again by clicking the Conditions button
on the Button bar.

If you received satisfactory results from a step, click the OK
icon to display the next guided step for trcubleshooting this
fault.

if, after performing a step, the results are not satisfactory,
click the Not OK icon. A pop-up window provides summary
information about what to do to correct the problem. Once

the problem is repaired, click the Repair Complete text in the
pop-up window to go to the next guided step.

At any time you can also click:

Summary Text to display the next summary step for this
fault.

Troubleshooting Steps to disptay the high-level outline of
troubleshooting steps.
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Snapshot Dialog Box

The Snapshot Dialog Box displays key engine sensor and switch
data for each fault selected in the Fault Information dialog box.

Sensors and switches are listed in the Snapshot Data column.
The corresponding values display for the first and last
occurrences of the selected fault.

Sna -

ternate Frequency Switch Input
atery Yollege
mmandad Fack Positon
ACoolant Temperature
i Diagnostic Switch
Engine Speed
Fault Code ECM Time
FSOV Qutput
Idle Rated Switch input
Qil Pressure
Aun Stap Switch Input
4Speed Adjust Input

Snapshot Dialog Box

Fault Code: A numeric Cummins code that identifies the fault.
Refer to the Fault Information System for a detailed explanation
of a specific fault code.

Count: The first box indicates the total number of occurrences of
this fault since the last time fault data was cleared.

The second and third boxes show the total number of different -
faults for this engine and the relative position of this fault in that
group. For example, 7 of 10 indicates that there are 10 different
fauits recorded for this engine and this is the seventh of those ten
faults.

ECM Time Since Last Occurrence: indicates how much ECM
time has elapsed, in hours and minutes, since the fault was last
recorded. For example, a value of 20:10 indicates that 20 hours
and 10 minutes has elapsed, in ECM time, since the last fault of
this type gccurred.

Buttons in the Snapshot Dialog Box

Click the Next or Prev buttons to view sensor and switch data for
the next or previous fault listed in the Fault Information dialog
box.
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Tests Menu

Use the Tests menu fo perform diagnostic tests on an engine.

Tests Menu

Each command on the Tests menu is described in the following
sections.

Fuel Pump Rack Test

Use the Fuel Pump Rack Test command on the Tests menu to
help troubleshoot the fuel pump rack, the rack actuator circuit, or
the rack position sensor circuit. This test can only be performed
when the engine is nof running.

The test allows you to position the fuel pump rack between 0 and
20 mm of rack travel. For any position you command, the test
displays the voltage you should read on the rack position signal
wires at the engine hamess diagnostic connector.

R i

Fuel Pump Rack Test Dialog Box

Commanded Value: The desired rack position to use for
diagnostic testing.
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Corresponding Rack Position Sensor Voltage: The correct
voltage for the rack position selected in the Commanded Value
field. This value should correspond to the actual voltage
measured at the hamess.

To change the rack position:

» Use the up or down arrows to change the position setting.
The new value is automatically sent to the ECM, or

Type a new value in the data entry field. You must also click
the Send button to send the new value to the ECM.

Relay Driver Tests

Use the Relay Driver Tests command on the Tests menu to
toggle the available relay drivers on or off for diagnostic testing.
The test can be used to help troubleshoot the ECM relay driver
output, the relay being driven, the relay wiring, and the device
('amps, alarms, etc.) being activated.

. nzlay )ivast

>

e

Relay Driver Tests Dialog Box

When you open the Relay Driver Tests dialog box, current ECM
settings display for the listed parameters. When you close the
dialog box, the settings automatically retum to their original
positions.

Common Warning: The output relay for the common warning
SEensor.

Common Shutdown: The output refay for the common
shutdown sensor.

High Coolant Temperature Warning: The cutput relay for the
high coolant temperature warning sensor.
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CAUTION! Fauit simulation
temporarily overrides the
engine’s actual fault sensors.
Be sure to exit the Fault
Simulation tabs normally,
using either the Cancel buaion
or the Windows 95 close
window button. Otherwise the
fault sensors remain disabled,
leaving the engine defenseless
if an actual fawlt occurs.

If your PC shuts down for ary
reason during simulation, you
must power off the engine and
restart it for the fault sensors
to be reactivated.

High Coolant Temperature Shutdown: The output relay for the
high cooclant temperature shutdown sensor.

Low Oil Pressure Warning: The output relay for the low oil
pressure warning sensor.

Low Oil Pressure Shutdown: The output relay for the low oil
pressure shutdown sensor.

Overspeed Shutdown: The output relay for the overspeed

shutdown sensor.

To select a parameter for testing:

* Click the On radio button to energize an output for a
parameter.

Click the Off radio button to de-energize an output for a
parameter.

Fault Simulation Test
Use the Fault Simulation Test command on the Tests menu to

simulate conditions in the engine that would cause faults. This is

useful for testing the proper functioning of the fault information
system including fault sensors and fault diagnostics.

Click the tabs in the dialog box to view fault simulation options

for;

« Low Gil Pressure
+ High Coolant Temperature

s Overspeed

After completing simulation, use the Fault Information command
on the View menu to check the results of fault simulation

including fault codes and associated snapshot data. See page
17 for more information.

Working with Tab Dialogs

When the Fault Simulation dizlog box first displays, the Low Qil
Press tab dialog displays in the forefront.

To display a different tab:

¢ Click the tab you want to display.
The selected tab is highlighted and moved to the forefront.

Each tab is described in the following sections.
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CAUTION! Fault simulation
temporarily overrides the
engine’s actual fault sensors.
Be sure to exit the Fault
Simulation tabs normally,
using either the Cancel button
or the Windows 95 close
window butron. Otherwise the
fault sensors remain disabled,
leaving the engine defenseless
if an actual fawir occurs.

If your PC shuts down for any
reason during simulation, you
must power off the engine and
restart it for the fault sensors
to be reactivated.

Low Qil Pressure

Use the Low Oil Pressure tab dialog box to simulate an oil
pressure condition that would cause a fault. You can override the
actual sensor input value by adjusting the simulated value. The
control system then responds to the simulated value as if it were
the actual input.

After completing simulation, use the Fault Information command
on the View menu to check the results of fault simulation including
fault codes and associated snapshot data. See page 17 for more
information.

Fault Simul Hlil] 7

Low Qil Pressure Tab Dialog

Actual Oil Pressure: The current engine oil pressure, read from
the ECM.

Simulated Pressure: This spin box enables you to temporarily
change the engine oil pressure in order to simulate an oil
prassure fault.

Warning Threshold: The current warning threshoid value in the
ECM. You can change this value using the Field Parameter
Editor; see page 13 for more information.

Shutdown Threshold: The shutdown threshold value in the
ECM.

To simulate an oil pressure condition that causes a fault:

Note: The Simulated Pressure spin box is Inactive when you first
see the tab. Clicking an up or down arrow activates the spin box,
displaying the current oif pressure read from the ECM.

» Click an up or down arrow again to simulate changing the
current pressure in 1 unit increments. This value is
automatically sent to the ECM, or
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CAUTION! Fault simulation
temporarily overrides the
engine's actual fault sensors.
Be sure to exit the Fault
Stmulation tabs normally,
using either the Cancel button
or the Windows 95 close
window burton. Otherwise the
faudt sensors remain disabled,
leaving the engine defenseless
if an actual fault eccurs.

If your PC shuis down for any
reason during simulation, you
must power off the engine and
restari it for the fault sensors
to be reactivated.

* Type a simulated pressure value in the data entry field. You
must also click the Send button to send the value to the
ECM.

The simulated oil pressure condition remains in effect for 20
seconds, then control returns to the actual engine sensors.

High Coolant Temp

Use the High Coolant Temp tab dialog box to simulate a coolant
temperature condition that would cause a fault. You can override
the actual sensor input value by adjusting the simuiated value.
The control system then responds to the simulated value as if it
were the actual input.

After completing simulation, use the Fault Information command
on the View menu to check the results of fault simulation
including fault codes and associated snapshot data. See page
17 for more information.

B

High Coolant Temp Tab Dialog

Actual Temperature: The current engine temperature, read
from the ECM.

Simulated Temperature: This spin box enables you to
temporarily change the engine coolant temperature in order to
simulate a coolant temperature fault.

Warning Threshold: The current warning threshold value in the
ECM. You can change this value using the Field Parameter
Editor. See page 13 for more information.

Shutdown Threshold: The shutdown threshold value in the
ECM.
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To simulate a coolant temperature condition that causes a
fault:

Note: The Simulated Temperature spin box is Inactive when you
first click the Coolant Temp tab. Clicking an up or down arrow
activates the spin box, displaying the current coolant temperature
read from the ECM.

» Click an up or down arrow again to simulate changing the
current temperature in 1 unit increments. This value is
automatically sent {o the ECM, or

Type a simulated temperature value in the data entry field.
You must also click the Send button to send the value o the
ECM.

The simulated coolant temperature condition remains in effact for
20 seconds, then control returns 1o the actual engine sensors.

Overspeed

Use the Overspeed tab dialog box to simulate an overspeed
candition that would cause a fault. You can adjust the shutdown
threshold to the desired test point, and then change the engine
speed to that point by adjusting Rated Speed Override.

After completing simulation, use the Fault Information command
on the View menu to check the results of fault simulation
including fault codes and associated snapshot data. See page
17 for more information.

Overspeed Tab Dialog

Actual Speed: The current engine speed, read from the ECM.

Rated Speed Override: Uss this spin box to increase the
engine's operating speed in order to simulate an overspeed fault.
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Shutdown Threshold: The shutdown threshold value in the
ECM. You can change this value, in order to simulate a fault,
using the spin box.

To simulate a speed override condition that causes a fault:

Note: The Rated Speed Override spin box is Inactive when you
first click the Overspeed tab. Clicking an up or down arrow
activales the spin box, displaying the current override speed read
from the ECM.

» Click an up or down arrow again to simulate changing the
speed in 10 RPM increments. This value is automatically
sent to the ECM, or

Type a simulated speed value in the data entry field. You
must also click the Send butten to send the value to the
ECM.

The shutdown threshold value can be altered, just for this test, in
its spin box.

Tools Menu

Use the Tools menu 1o control an engine using INSITE™ QST30
G-Drive, and to calibrate the ECM meters, You can also monitor
a running engine and save current diagnostic information to a
file. Bath functions are useful for troubleshooting and general
engine diagnostics.

Use the Reset commands on this menu to return the ECM to
original factory settings.

Tools Menu

Each command on the Tools menu is described in the following
sections.
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Control Panel

Use the Contrel Panel command on the Tools menu to controi a
running engine directly from INSITE™ QST30 G-Drive. This is
useful for diagnostics when the actual engine controls are not
located on or near the engine.

Contrul Panel

Control Panel Dialog Box

Engine Performance Adjustments

The Engine Performance Adjustments section of Control Panel
displays current engine settings read from the ECM. You can
control the engine directly from here by changing the values
displayed.

Use the spin boxes or type in the data entry fields to adjust the
engine settings up or down.ldle Speed: Use the Idle Speed spin
box to adjust the engine's idle speed up or down.

Paralleling Scale Factor: Use the Paralleling Scale Factor spin
box to adjust the engine's paralleling scale factor up or down.

Governor Gain: Use the Governor Gain spin box to adjust the
engine’s governor gain up or down.

Governor Droop: Use the Governor Droop spin box to adjust
the engine’s govermnor droop up or down.

Input Overrides

The Input Overrides section of Control Panel enables you to
control switched inputs to the ECM directly from INSITE™ QST30
G-Drive.

Alarm Reset: Click the Alarm Reset button to reset the engine's
fault indicators. This button functions the same as the actual
Alarm Reset switch.
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Speed Switch: Use the Speed Switch radio buttons to set the
engine’s operating speed to either Idle or Rated. These radio
buttons function the same as the actual |dle and Rated speed
switches.

Rated Speed Override: Use the Rated Speed Qverride spin box
to increase or decrease the engine’s operating speed.

To change adjustable parameters:

+ Use the up or down arrows to change the parameter value.
The new value is automatically sent to the ECM, or

* Type a new value in the data entry field. You must also click
the Send button to send the new value to the ECM.

In both cases, the new value is not saved permanently in the
ECM until you click the ECM Save button.

Note: The Rated Speed Override spin box is Inactive when you
open Control Panel. Clicking an up or down arrow aclivates the
override feature, displaying the current rated speed. Click an up
or down arrow again lo change the rated speed.

To activate the Speed Switch:

» Click either the |dle or Rated radio buttons to set engine
speed. These butions are blank (inactive) when you open
Control Panel, and are not activated until you click one of
them.

To de-activate the Speed Switch:

s Click once on an active button. This removes the mark, and
both buttons are blank (inactive) again.

Buttons in Control Panel

Click the Send button to activate new parameter vaiue(s) in the
ECM for diagnostic purposes. Click the ECM Save button to
permanently change the values in the ECM.

Use the Cancel button to close the dialog box.
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Meter Calibration

Use the Meter Calibration command on the Tools menu to set
your meter displays and also to verify correct meter functioning.

Click the tabs in the Customer Meter Calibration dialog box to view
meter calibration options for:

e Coolant Temp
s  Qil Pressure

Working with Tab Dialogs

When the Customer Meter Calibration dialog box first displays, the
Coolant Temp tab dialog displays in the forefront.

To display a different tab:
o Click the tab you want to display.
The selected tab is highlighted and moved to the forefront.

Each tab is described in the following sections.

Coolant Temp

Use the Coolant Temp tab dialog to set your coolant temperature
meter display, and also to verify correct meter functioning.

Coolant Temp Tab Dialog

Minimum Meter Display: Displays the currant ECM value for
minimum meter display. This value can be changed using the
Field Parameter Editor. See page 13 for more information.

Maximum Meter Display: Displays the current ECM value for
maximum meter display. This value can be changed using the
Field Parameter Editor.

Maximum Display Adjustment: Edit this percentage setting up
or down until the engine RPM meter needle tops out at exactly
the maximum value on the meter.

Test Calibration: Use this spin box to test meter functioning by
sending unit increments or decrements to the ECM.
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The spin box is Inactive when you open the Customer Meter
Calibration dialog box. Clicking an up or down arrow activates the
feature, displaying the current value. Click an up or down arrow
again to change the current value.

To change parameter settings:

* Type values into the data entry boxes or use the spin boxes
to select values.

Qil Pressure

Use the Oil Pressure tab dialog to set your oil pressure meter
display and also to verify correct meter functioning.

Customer Meter Calibration

%

Oil Pressure Tab Dialog

Minimum Meter Display: Displays the current ECM value for
minimum meter display. This value can be changed using the
Field Parameter Editor. See page 13 for more information.

Maximum Meter Display: Displays the current ECM value for
maximum meter display. This value can be changed using the
Field Parameter Editor.

Maximum Display Adjustment: Edit this percentage setting up
or down until the engine RPM meter needle tops out at exactly
the maximum value on the meter.

Test Calibration: Use this spin box to test meter functioning by
sending unit increments or decrements to the ECM.

The spin box is Inactive when you open the Custormer Meter
Calibration dialog box. Clicking an up or down arrow activates the
feature, displaying the current value. Click an up or down arrow
again to change the current value.

To change parameter settings:

+ Type values into the data entry boxes or use the spin boxes
to select values.
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Buttons in the Customer Meler Calibration Tab Dialogs

Click the Send button to activate new parameter value(s) in the
ECM for diagnostic purposes. Click the ECM Save button to
permanently change the values in the ECM.

Use the Cancel button to close the dialog box.

Tachometer Calibration

Use the Tachometer Calibration command on the Tools menu to
set your tachometer display and aiso to verity correct meter
functioning.

Tahn meter Calibration

o

Tachometer Calibration Dialog Box

Actual Engine RPM: The current engine RPM, read from the
ECM.

Minimum Meter Display: Displays the current ECM value for
minimum meter display. This value can be changed using the Field
Parameter Editor. See page 13 for more information.

Maximum Meter Display: Displays the current ECM value for
maximum meter display. This value can be changed using the
Field Parameter Editor.

Maximum Display Adjustment: Edit this percentage setting up or
down until the engine RPM meter needle tops out at exactly the
maximum value on the meter.

Rated Speed Override: Use the Rated Speed Override spin box
to increase or decrease the engine’s operating speed until the
Maximum Meter Display value equals the desired position on the
ECM meter. If necessary, adjust the Maximum Display
percentage up or down to accomplish this.

The spin box is Inactive when you open the Tachometer
Calibration dialeg box. Clicking an up or down arrow activates the
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override feature, displaying the current rated speed. Click an up
or down arrow again to change the current speed.

Note: The override feature is temporary only and cannol be
saved io the ECM.

Buttons in the Tachometer Calibration Dialog Box

Click the Send button to activate new parameter value(s) in the
ECM for diagnostic purposes. Click the ECM Save button to
permanently change the values in the ECM.

Use the Cancel button to close the dialog box.

Monitor

Use the Monitor command on the Tools menu to view specific
parameters of a running engine. First you specify in the Monitor
Setup dialog box which parameters to monitor and display.

Then, the Monitor dialog box shows the latest status of ECM
inputs and outputs. This is a convenient way of checking the
operation of each ECM input circuit without disconnecting the
circuit from the ECM.

Your PC must be connected to an ECM on a running engine to
use the diagnostic tests. The engine does not have to be running
to monitor the switches only, but the ECM must be in the
diagnostic mode.

Using the Monitor Feature
Follow these steps:
1. Select the Monitor command on the Tools menu.

2. Specify which parameters to display in the Monitor Setup
dialog box.

See the following sections for more infermation.
Begin monitoring the data in the Monitor dialog box.

Ses “Beginning the Data Monitoring Process” on page 42 for
mere information.

Available Paramelers

The following parameters are available in the Monitor Setup and
Data Logger Setup dialog boxes.

Alarm Reset Switch Input: Either depressed (On) or released
(Off).

Alternate Frequency Switch Input: Either Normal or Altemate.
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Barber Colman Bias: RPM increase or decrease (This
parameter displays only if Barber Colman is enabled in Features
and Parameters).

Battery Voltage: The unswitched battery supply voltage at the
ECM.

Commanded Rack Position: The rack position commanded by
the ECM.

Common Alarm: Lamp indicator = On or Off.

Common Warning: Lamp indicator = On or Off.

Coolant Temperature: The value read from the ECM.
Coolant Temperature Meter Driver: Duty cycle percentage.
Coolant Temperature Shutdown: Lamp indicator = On or Off.
Coolant Temperature Warning: Lamp indicator = On or Off.

Diagnostic Switch: Either On or Off. (On = Diagnostic mode,
Off = Running mode).

ECM Run Time: The total amount of time the ECM has been
powered On, regardless of whether or not the engine has been
running.

Engine Run Time: The value read from the ECM.
Engine Speed: The value read from the ECM.
Engine Speed Meter Driver: Duty cycle percentage.

Fuel Shutoff Valve: Either On or Off (Note: The setting applies
to both shutoff vaives),

Idle Rated Switeh Input: Either |dle or Rated.
Mode: The current operating state.
Oil Pressure: The value read from the ECM.

Oil Pressure Meter Driver: Duty cycle percentage.
Qil Pressure Shutdown: Lamp indicator = On or Off.

Qil Pressure Warning: Lamp indicator = On or Off.
Overspeed Shutdown: Lamp indicator = On or Off.
Run Stop Switch Input: Either Run or Stop.

Speed Adjust Input: A plus or minus RPM value caused by the
Speed Adjust Knob.

Speed Adjust Knob: Either enabled or disabled.

Speed Bias Input Type: From Features and Parameters: either
Barber Colman, Woodward, or Disabled.

Version Number: The ECM software version number.

Woodward Bias: RPM increase or decrease (This parameter
displays only if Woodward is enabled in Features and
Parameters).
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Specifying Which Parameters to Monitor

Before monitoring data, you must specify which parameters to
monitor. Either select a new group of parameters to monitor or
use an existing custom monitor setup.

The first time you use the monitor feature, you must select a new
group of parameters to monitor. After that, you can use a saved
setup or create a new setup with different parameters.

To specify a new group of parameters to monitor:
1. Click Monitor on the Tools menu,

The Monitor Setup dialog box displays. The Available
Parameters scroll box lists all of the parameters that can be
monitored.
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Monitor Setup Dialog Box

Include in the Selected Parameters scroll box the names of
the parameters you want to monitor.

To add a parameter to the Selected Parameters box, select
the name of the parameter in the Available Parameters box
and click the Add button, or double-click the name in the
Available Parameters box.

To delete a parameter from the Selected Parameters box,
select the name of the parameter in the Selected Parameters
box and click the Delete button, or double-click the name in
the Selected Parameters box.

If you make a mistake and want to start over, click the Clear
button. You will be prompted to confirm that you want to
erase all of the entries in the Selected Parameters box. If you
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click OK, all of the parameters wiil be deleted from the
Selected Parameters box and you can rebuild the list.

1 this is a custom monitor setup that will be used again, click
the Set button.

A standard Windows Save As dialog box displays. Fill it in as
usual using a file name extension of .cfg. Then, click OK.

As an option, fill in the Destination File name to specify a log
file name for capturing this monitored information to a log file.

A default destination file name of MONITOR.DAT displays.
This file name is used when you click the Capture button on
the Monitor dialog box. The captured data is stored in
standard log file format with a .DAT file and a .HDR file. Both
files use the same file name that you specify. Log files are
stored in \Log.

5. Click OK to start monitoring data with this setup.

To use an existing custom monitor setup:

1.

Click Monitor on the Tools menu.
The Monitor Setup dialog box displays.
Click the Get button in the Monitor Setup dialog box.

A standard Windows Open dialog box displays. Specify the
file location as usual and click OK. The custom monitor setup
files are stored in the \Log directory.

3. Click OK to start monitoring data with this setup.

Beglinning the Data Monitoring Process

Once the Monitor dialog box displays, you can monitor and
display realtime data from the ECM.

To monitor data:

1.

Specify which parameters to monitor.

For more information, see “Specifying Which Parameters to
Monitor” on page 40.

Make sure the ECM is attached to your PC and the engine is
running.
Click the Start button in the Monitor dialog box.

As data is read from the ECM, values display on the screen
for each parameter. These values are updated automatically
while the engine is being monitored.

For each parameter, the following items display:
Parameter: The name of the parameter being monitored.
Value: The data value of the parameter.

Units: The unit of measurement for the value.
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Monitor Dialog Box

To pause and then start the monitoring process again, click
the Pause button and then click the Start button again.

This is useful if the engine state changes temporarily and you
want to stop the monitoring process until the engine retums
to its previous state.

To capture monitored data to a log file, click the Capture
button.

The log files are stored in \Log. The file names correspond to
the Destination File name specified in the Monitor Setup
dialog box.

To stop monitoring the engine, click the Close button. You
return to the INSITE™ QST30 G-Drive Main window.

Data Logger

Use the Data Logger command on the Tools menu to save data
frem a running engine to a data file. This data file can be imported
into a spreadsheet or graphics application for reporting, graphing,
or further analysis.

The Data Logger feature helps troubleshoot engine problems by
allowing you to isolate and analyze specific operating parameters
over time. For example, if an engine is overheating, you can log
the coolant temperature at specific intervals to pinpoint the cause
of overheating. You can specify which types of data to log to the
data file and when to record the data.
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Logging Data to a File

Follow these steps:

1. Select the Data Logger command on the Tools menu.
2. Specify the parameters that you want to log.

Also specify the data file name and the frequency of the
sampling period. See the following section for more
information.

Start the data logging process.

See “Beginning the Data Logging Process” on page 46 for
more information.

Specifying Which Parameters to Log

Before logging data to a log file, you must either open an existing
configuration file or select a new set of parameters to log. When
using the data logger function for the first time, a new set of
parameters must be created. After that, you can use a saved
configuration file again or create a new set of parameters to log.

You can specify an unlimited number of parameters to log. Keep
in mind that the more parameters that are logged, the more time
it takes to log the data.

See page 39 for a list of the Available Paramsters.

To select a new set of parameters to log:
1. Click Data Logger on the Tools menu.

The Data Logger Setup dialog box displays. The Available
Parameters scroll box lists all of the parameters that can be
logged.

Fill the Selected Parameters scroll box with the names of the
parameters you want to log.

To add a parameter to the Selected Parameters box, select
the name of the parameter in the Available Parameters box
and click the Add button, or double-click the name in the
Available Parameters box.

To delete a parameter from the Selected Parameters box,
select the hame of the parameter in the Selected Parameters
box and click the Delete buttan, or double-click on the name
in the Selected Parameters box.

If you make a mistake and want to stari over, click the Clear
button. You will be prompted to confirm that you want to
erase all of the entries in the Selected Parameters box. If you
glick OK, all of the parameters will be deleted from the
Selected Parameters box and you can rebuiid the list.

3. Enter a sampling period and a name for the data file.
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It may take a few seconds to
gather a complete set of data
(the data does not reflect a
single point in time, but rather
a short range of time). After
each set of data is collected,
the sampling period passes,
and a new set of data is
gathered.
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Data Logger Setup Dialog Box

Destination File: The name of the data file. Enter a name of
up to eight characters. This name will be used to create a
header file with an extension of .HDR, and a data file with an
extension of .DAT. If you do not specify the file name,
INSITE™ uses a default file name of LOGXXXXX.DAT,
where XXXXX is the next sequential number in the series
starting from 00001,

Sampling Period: The time interval that you want to pass
between data “snapshots”. For example, if you choose 10
seconds, INSITE™ QST30 G-Drive will poll the ECM for data
at 10-second intervals. The Real Tirne option allows you to
perform continuous polling, reading between two and five
values per second depending on your hardware and software
configuration. If you do not specify a sampling period,
INSITE™ QST30 G-Drive uses a default sampling period of
Real Time.

To save these parameters in a configuration file for later use,
click the Set button.

A standard Windows Save As dialog box displays. Fill it in as
usual and click OK. Use a file name extension of .cfg.

Click OK to start logging data with these preferences.

The Data Logger dialog box displays. For more information,
see “Beginning the Data Logging Process” on the next page.

To open an existing configuration file for logging data:
1. Click Data Logger from the Tools menu.
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The higher the number of
datasets logged, the greater
the amount of disk space

required. To conserve disk
space, keep the number of

datasets logged to a minimum.

Typically, you do not need
more than 100 datasets to
generale an adequate amount
of data.

As logging progresses, free
space is checked 1o make sure
that there is enough space to
write to a file. If the log file
grows so large that there is
not enough disk space to
conitain i, you will be
prompted to close the log file
and logging will be stopped,

The Data Logger Setup dialog box displays.
Click the Get button.

A standard Windows Open dialog box displays. Specify the
file location as usual and click OK. Configuration files for
INSITE™ are stored in the \Log subdirectory.

Click OK to start logging data with this configuration file.
The Data Logger dialog box displays.

Beginning the Data Logging Process

After specifying which parameters to use, you can begin logging
data in the Data Logger dialog box.

To log data in the Data Logger dialog box:

1.

2,

Make sure the ECM is attached to your PC and the engine is
running.

Click the Start button to begin the data logging process.

Time Elapsed: The amount of time that has passed since
the data logging process began. The time elapsed measures
the actual data logging time; it does not include any pause
periods. This value is updated as data is logged from the
engine.

Datasets Logged: The number of data sets that have been
logged during this data iogging session. This value depends
on the sampling period specified in the Data Log Setup dialog
box and the time elapsed. The value is updated as data is
iogged from the engine.

Data Logger Dialog Box

Destination File: The name of the data file that will store the
logged data. If you entered a file name on the Data Log Setup
dialog box, it will display here. If not, a default name with the
format LOGXXXXX.DAT will display.
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Comment: A note that can be included to describe this set of
logged data. The comment displays in the header file as a
reference.

To pause and start the logging process again, click the Pause
button and then the Start button again.

This is useful if there is a temporary change in engine state
that you do not want to record. Press the Pause button until
the engine returns to its previous state.

4. To stop logging data, click the Close button.

Deleting Log Files

It is easy to accumulate many log files, each of which can contain
large amounts of data. Check your log files frequently and
regularly delete any unnecessary files using Explorer. The
INSITE™ QST30 G-Drive log files are stored in \Log.

Partial Reset

Use the Partial Reset command on the Tools menu to reset
features and functions in the ECM that do not affect customer-
defined settings.

Note: This function should not be performed unless it is
recommended by either the Fault Information System or the
Troubleshooting and Repair Manual.

The Partial Reset command does not erase any customer-
defined settings from the ECM, such as parameter adjustments
and meter calibrations.

After selecting this command, you must power the ECM off and
then back on again for the reset to take effect.

Full Reset

Use the Full Reset command on the Tools menu to reset all
features and functions in the ECM to their default settings. This
command returns the ECM to its original factory settings.

Note: This function should not be performed unless it is
recommended by either the Fault Information System or the
Troubleshooting and Repair Manual.

WARNING! The Full Reset command also erases all customer-
defined settings from the ECM, such as parameter adjustments
and meter calibrations.

After selecting this command, you must power the ECM off and
then back on again for the reset to take effect.
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System Menu

Use the System menu to set options for working with INSITE™
QST30 G-Drive, including setting the COM port and units of
measure.

You do not have to be connected to an ECM to use the
commands on this menu.

System Menu

Each command an the System menu is described in the following
sections.

User Options
Use the User Options command on the System menu to set the
COM port on your PC to use with INSITE™ QST30 G-Drive.

You also use the User Options command if you are not connected
to an ECM and want to run INSITE™ QST30 G-Drive in Simulator
mode. Simulator modes are explained on the next page.

Port Setup. changing from Sim R

User Options Dialog Box
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The COM port or Simulator mode you are using is specified in
the title bar of the dialog box.

Note: If you are not connected to an ECM the first time you run
INSITE™ QST30 G-Drive, the application automatically opens in
Simulator (Sim A} mode.

To specify a COM port:

1. Select the port you want to use in the Port Number list by
highlighting the port number.

2. Click the OK button.

The selected port setting is activated immediately.

Using Simulator Modes

Simulator modes are provided so that you can use INSITE™
QST30 G-Drive without being attached to an ECM. These modes
are useful for training, viewing ECM parameters, or any other
situation where you are not or cannot be connected to an ECM.

You do not need a Security key to use a Simulator mode.

To use a Simulator mode:

1. In the Port Setup dialog box, highlight either Sim R or Sim S
in the Port Number list.

2. Click the OK button.
The selected Simulator mode is activated immediately.

Differences between Sim R and Sim S

Sim R (Running mode):

s INSITE™ QST30 G-Drive functions as if you were attached to
a running engine.

» No features or commands are available that require the
engine to be not running. These include the Field Parameter
Editor, the Fuel Pump Rack Test, Meter Calibration, etc.

Sim S (Diagnostic mode):

e INSITE™ QS8T30 G-Drive functions as if you were attached to
an engine that is not running.

« All diagnostic features and commands are available.
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Units of Measure

Use the Units of Measure command on the System menu to
specify the measurement units you want to use for coolant
temperature and oil pressure. This preference setting affects the
dispiay of data only. Data is always stored in standard U.S. units.

System of Measuremen

i i
Units of Measure Dialog Box

To specify the units of measurement for coolant

temperature and oll pressure:

1. Select the name of a region or measurement system in the
list by highlighting it.

2. Click the OK button.

Administrator Submenu

Use the Administrator submenu on the System menu to move,
install, or view Security information for INSITE™ QST30
G-Drive.

Administrator Submenu

Each command on the Administrator submenu is described in
the following sections.
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Security Move

| Use the Security Move command on the Administrator submenu
to move the security key for this copy of INSITE™ QST30
G-Drive. You can move the key to or from your hard disk.

To move the security key:

1. Insert the security key diskette in the diskette drive. In the
Move Security Key dialog box, click the radio button that
corresponds to the type of move you want.

Move Security Key Dialog Box

2. Select the drive letter of your diskette drive in the spin box.
3. Click OK.

Security Install

Use the Security Install command an the Administrator submenu
to install a security key after INSITE™ QST30 G-Drive has already
been instalied. A security key must be present on either a diskette
or the PC’s hard drive in order to use INSITE™ QST30 G-Drive for
diagnostics.

To install security:

1. Insert the security key diskette in the diskette drive. In the
ECM Setup dialog box, click either the Drive A or Drive B
radio buttons, depending on your PC's configuration.

2. Click OK.

3. Type your password in the Password field. The password is
unique to your copy of INSITE™ QST30 G-Drive.

You also have the option of transferring the security key to
your hard drive. This is recommended, since otherwise you
will always need the original security diskette in order to use
INSITE™ QST30 G-Drive.
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ECM Setup (Password) Dialog Box

Note: If you do transfer security to the hard drive, be sure to
keep your original security key disketfe in a safe place. If you
later decide fo transfer security back Io the diskette, you
need lo use the original diskette.

4, Click OK,

Security Information

Use the Security Information command on the Administrator
submenu to identify;

¢ The location of the security key for this copy of INSITE™ QST30
G-Drive.

¢ The serial number of the original security key diskette that was
used to install security.

52 » Menus and Commands INSITE™ QST30 G-Drive User's Manual




infarmation

Security Information Window

Drive: Indicates which drive contains the security key: either A,
B, or C. You need to know the drive letter if you want to move
your security key.

Serial Number: The twelve digit serial number on the security
key diskette that was originally used to install security. You must
use the original security key diskette if you want to move security
from drive C to the diskette.

Note: If question marks appear in both fields, either securily is
not installed or there is a problem. See your systermn administrator
or contact Service and Support.

Click OK to close the Security Information window.

Help Menu

Use the Help menu to get information about how to work with
INSITE™ QST30 G-Drive. You can access the Help system any
time; your PC does not need to be connected to an ECM.

Help Menu
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Each command on the Help menu is described in the following
sections.

Contents

Use the Contents command on the Help menu to display the
Table of Contents of the INSITE™ QST30 G-Drive Help Systern.
Click icons or underlined text to move throughout Help.

Search for Help On

Use the Search for Help On command from the Help menu to
select keywords to search on and display related topics.

To search for help by topic title:
1. Select a topic title in the list box and click the Display button.

To select a topic title, either scroll through the list of topics in
the list box, or type the first letter(s) of the topic you want to
find.

2. The selected help topic displays.

To search for help by individual words:

1. Click the Find tab.

2, Click the Next button in the Find Setup Wizard dialog box.
3. Click the Finish button in the Find Setup Wizard dialog box.
4

Type a word in field 1 or select a word in field 2.

All Help topics which contain your selection are listed in field 3.
Select a topic and click the Display button.

The selected help topic displays.

Note: You can cuslomize your search options in the Find tab using
the buttons on the right. See the Windows® 95 documentation for
details.

How to Use Help

Use the How to Use Help command from the Help menu for
instructions on how to use a Windows® Help system. This
information includes how to use a keyword search list, how to
browse through help screens, and how to retrace your steps when
using Help.
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Service and Support

Use the Service and Support command on the Help menu to
display pertinent telephone numbers and addresses for you to get
more information about using INSITE™ QST30 G-Drive.

About

Use the About command on the Help menu to display identifying
information about the use of INSITE™ QST30 G-Drive at your
location. This information includes the serial number and version
number for this copy of the software. This information is helpful
when seeking technical support.
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Menu Maps

This section illustrates the paths to take from each menu to get
to each of the dialog boxes in INSITE™ QST30 G-Drive. Use this
section as a visual guide to find the dialog box you want.

This section is organized by menu, in the order that the menus
display on the Menu bar.
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Job Menu

Adjustments Menu

{Alternate Fraquency Switch Setongs
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die Speed
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| Meter Maximum Oil Pressure

Meter Maximur Temperature
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View Menu

ault Information

R
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2
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2
2
4
H
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Tests Menu

Fuel Pump Rack Test
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Fault Simulation

Fault Simulat
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System Menu
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Reference Information

Communications Messages

If you encounter a communications error of any kind, follow these
troubleshooting steps:

To troubleshoot a communications problem:

1. Check the COM port setting in the User Options dialog box to
make sure it is correct.

Check the cable connections o make sure all cables are
securely in place.

Make sure the ECM is powered ON.
Try the function again.

if the problem persists, exit from INSITE™ QST30 G-Drive
and contact your system administrator for assistance.
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Glossary

Alarm Reset Switch

The alarm reset switch is used to send a signal to the ECM to
reset any active fault indicators. The switch does not clear any
actual fault codes — it merely clears the fault indicators (lamps,
alarms, etc.).

If the engine was shut down by an active fault, the ECM will not
allow the engine to be restarted until the fault has been reset with
the alarm reset switch.

Alternate Frequency Switch Settings

The alternate frequency switch tells the ECM what frequency {50
or 60 Hz) the generator set cperator wishes to use to generate
electricity. The ECM uses this input to determine at what speed
the engine should tumn the generator. To change frequencies, the
engine must first be shut down or brought to idle then back to
rated speed.

The ECM input for this switch can be configured for Normai = 60,
Alternate = 50; Normal = 50, Alternate = 60; Always 60; or
Always 50. The Always 60 or Always 50 options wili disable the
switch and lock the input to the selected frequency.

ASCI

The American Standard for Communication and Information
Interchange format commonly used to exchange data.

Barber-Colman Scale Factor

Enables the ECM to be adjusted for optimum paralleling
operation when using Barber-Colman paralleling equipment. Also
see Speed Bias Inputs.

Check Box

A box that you click once to select an option, then click again to
de-select the option. You can select multiple check boxes in a
list.

Close button

The button at the top right corner of a window that is used to
close it. You can use this button in the main window to exit the
INSITE™ QST30 G-Drive application.
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Command
An option that you select on a menu.

Common Alarm Shutdown Output

The common alarm shutdown output is energized when a
shutdown condition is detected by the engine control system.
This output consists of a set of relay contacts rated for 2 Amps at
30 VDC and 12 Amps at 50 VDC. The outpui can be used to
drive lamps, buzzers, or any other alarm device mesting the
above specifications.

Common Shutdown

This output is energized whenever any shutdown fault becomes
active. Shutdown faults will shut the engine down and prevent a
re-start until the fault has been reset.

Common Warning

This output is energized whenever any warning fault becomes
active, Warning faults indicate a pending shutdown if conditions
worsen. The engine will continue to operate during a waming
fault.

Coolant Temp Warning Threshold

The coolant temperature at which the ECM will report and record
a waming fault condition.

Coolant Temperature Sensor

Measures the temperature of the coolant in the thermostat
housing. The ECM measures coolant temperature by measuring
the resistance of the sensor. It measures sensor resistance by
measuring the voltage drop across a known resistance in the -
ECM that is in series with the temperature sensor.

Data Information Line {DIL)

A status line near the bottom of the main INSITE™ QST30
G-Drive window that displays the active function, the ECM part
number, and the current operating mode (i.e. Running,
Diagnostic, etc.).

Diagnostic Switch/Input

The diagnostic input to the ECM can either be connected to a

switch or terminated in the harness with a shorting cap. When
the diagnostic input is shorted to ground (through the switch or
cap), the ECM is in its normal state and will power down when
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the stop/run input is in the stop state and there are no active
faults. When the diagnostic input is removed from ground (open
circuited), the ECM enters diagnostic mode. This powers the
ECM up for service tool communication and diagnostic
troubleshooting.

Drop Down List Button

A button with a down arrow that you click with the mouse to
display a list of entries.

Dynamometer

A Cummins diagnostic tool used to measure the power output of
an engine.

ECM

The Electronic Control Module that contains the microprocessor
and related circuitry for QST30 engines.

ECM Run Time

The amount of time spent with the ECM powered on — regardless
of whether the engine is running or not.

Engine Offset Time

The actual runtime hours on the engine. The ECM value for this
parameter must be edited when a new ECM is installed on an
older engine, an older ECM on a newer engine, or if an engine is
rebuilt.

For example, if a new ECM is installed on an engine with 10,000
hours, you would enter 10,060 for Engine Offset Time. The new
ECM will now track Engine Run Time starting with the 10,000
hours run with the previous ECM.

Engine Run Time

The amount of time the engine was actually running (RPM > 0).
Time spent with the ECM powered up but the engine not running
does not get added to Engine Run Time.

Engine Speed Sensor

The engine speed sensor is mounted so that it can count the
teeth on the flywheel ring gear as the teeth pass in front of the
sensor. The sensor produces a frequency signal that the ECM
uses to calculate engine speed.
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Fault

Any problematic condition recorded while the engine was
operating.

Fuel Pump Rack Actuators

The ECM commands the desired fueling to the fue! pump
through the fuel pump rack actuators. The ECM has two outpuis,
one for each fuel pump, and controls the rack actuator with a
Pulse Width Modulated (PWM) signal.

A constant 24 VDC signal is sent from the ECM to the rack
actuator. The return signal from the actuator is then switched on
and off by the ECM to generate the PWM signal. This PWM
signal drives the fuel pump actuator, which in turn moves the fuel
rack to the desired rack position.

Fuel Pump Rack Position Sensor

The fuel pump rack position sensor provides the ECM with
information about the actual location of the fuel pump rack. The
ECM then compares this information with the commanded rack
position. If the two values do not match, the ECM will fog fauit
code 171.

The signal provided from the sensor is a sinusoidal signal
centered on a 2.5 VDC offset voltage. This signal received by the
ECM is compared to a reference signal to obtain the position of
the fuel pump rack.

Fuel shutoff valves
On/off solenoid valves used to cut off the supply of fuel to the

engine. The QST30 engine has a fuel shutoff valve on each
bank, one for each fuel pump. The valves open when the ECM
detects engine speed during cranking; they automatically shut
when power is removed. The ECM closes the valves under
certain fault conditions.

G-Drive

An engine designed and built for generator set assemblers and
GOEMs to be used in the power generation market. G-Drive
refers only to the engine part of an assembled generator set.

Genset

A completely assembled power generation set consisting of the
engine, alternator, cooling package, frame, and other mounting
hardware.
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GOEM
Generator Original Equipment Manufacturer

Governor Droop

The engine speed governor droop can be set to any value
between 0 and 10 percent.

High Coolant Temperature Shutdown

This output is energized when the coolant temperature exceeds
the cootant temperature shutdown threshold (nof adjustable by
INSITE™ QST30 G-Drive).

High Cooclant Temperature Warning

This output is energized when the coolant temperature exceeds
the coolant temperature warning threshold (adjustable by
INSITE™ QST30 G-Drive).

lcon
A graphic symbol that you click to open a window or program.

Idle/Rated Switch

This switch input instructs the ECM to run the engine at idle or
rated speed. The acceleration/deceleration time when switching
between idle and rated is adjustable with INSITE™ QST30
G-Drive.

idle Speed

The engine idle speed can be set to any value between 700 and
900 RPM.

Low Qil Pressure Shutdown

This output is energized when cil pressure draps below the Oil
Pressure Warning Threshold (adjustable by INSITE™ QST30
G-Drive).

Low Qil Pressure Warning

This output is energized when oil pressure drops below the Qil
Pressure Warning Threshold (adjustable by INSITE™ QST30
G-Drive).
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Maximize button

This button is used to enlarge a window to the full size of your
screen.

Menu Bar

A row of menu names near the top of the main INSITE™ QST30
G-Drive window.

Meter Coolant Temp Max Duty Cycle

Edit this percentage setting up or down until the coolant meter
needle tops out at exactly the maximum value on the meter.

Meter Drivers

The ECM provides meter driver outputs for engine speed, oil
pressure, and coolant temperature. Each meter driver is rated for
0 to 1 mA operation.

Meter Engine RPM Max Duty Cycle

Edit this percentage setting up or down until the engine RPM
meter needle fops out at exactly the maximum value on the
meter.

Meter Maximum Engine RPM

The value that displays at the upper limit of your meter scale. For
example, if the highest value on your meter is 2400 then you
should enter 2400 in the spinbox.

Meter Maximum Oil Pressure

The value that displays at the upper limit of your meter scale. For
example, if the highest value on your meter is 100 then you
should enter 100 in the spinbox.

Meter Maximum Temperature

The value that displays at the upper limit of your meter scale. For
example, if the highest value on your meter is 255 then you
should enter 255 in the spinbox.

Minimize button

This button is used to convert a window to a button on the
Windows® 95 taskbar, enabling INSITE™ QST30 G-Drive to run
in the background.
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Meter Minimum Engine RPM

The value that displays at the lower limit of your meter scale. For
example, if the lowest value on your meter is 0 then you should
enter 0 in the spinbox.

Meter Minimum Oil Pressure

The value that displays at the lower limit of your meter scale. For
example, if the lowest value on your meter is 0 then you should
enter 0 in the spinbox.

Meter Minimum Temperature

The value that displays at the lower limit of your meter scale. For
example, if the lowest value on your meter is 0 then you should
enter 0 in the spinbox.

Meter Oil Press Max Duty Cycle

Edit this percentage setting up or down until the cil pressure
meter needle tops out at exactly the maximum value on the
meter.

Qil Press Warn Threshold at Idle

The ail pressure at which the ECM will report and record a
waming fault condition at idle.

Oil Press Warn Threshold at Rated

The oil pressure at which the ECM will report and record a
warning fault condition at rated speed.

Qil Pressure Sensor

This sensor measures the capacitance between two circular
plates inside the sensor. As the measured pressure changes, the
distance between the two plates changes. This change in
distance changes the capacitance between the two plates. The
sensor has built-in circuitry that measures the capacitance and
turns it into a pressure signal that the ECM can use.

Overspeed Shutdown RPM

The engine speed at which the ECM will shut off the fuel supply
to the engine.
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Overspeed Shutdown

This ocutput is energized when engine speed exceeds the
Overspeed Shutdown threshold. The threshold can be lowered
from its defauit setting only with INSITE™ QST30 G-Drive.

Parameters
Operating values that govern how an engine performs.

PC
An |BM-compatible desktop or faptop computer.

Rack Position Voltages

The rack pasition voltage outputs from the ECM provide service
technicians with a voltage reading between 0 and 5 volts. This
voltage corresponds to the rack position detected by the fuel
pump rack position sensor. The ECM converts the sinusoidal
signal from the rack position sensor to a DC voltage that can be
read with a volt/ohm meter.

Radio Button

A mutually exclusive option that you select from a group of
options.

Ramp Time (Crank to Rated)

The amount of time it takes {in seconds) for the engine speed to
accelerate from crank to rated speed. See the Table of Ramp
Times on page 15.

Ramp Time (ldle to Rated)

The amount of time it takes (in seconds) for the engine speed to
accelerate from idle to rated speed. See the Table of Ramp
Times on page 15.

Relay Drivers

The ECM provides relay driver cutputs for high coolant
temperature, pre-high coolant temperature, low oil pressure, pre-
low oil pressure, and angine overspeed. These drivers are rated
for a maximum current of 200 mA at 24 VDC and should be used
to drive non-polarized relays. These relay driver outputs provide
individual notification for the five fault conditions listed above.

RPM
Revolutions per Minute.
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RS232 Datalink

The ECM provides an RS232 datalink connection for
communication with INSITE™ QST30 G-Drive. This datalink
connector can be found on the engine harness, near the flywheel
housing on the left hand side of the engine.

SAE
Society of Automotive Engineers.

Speed Adjust Knob

A variable resistor that enables adjustment of rated engine speed
by + 6 percent. This ECM input can be enabled or disabled using
INSITE ™ QST30 G-Drive.

Speed Bias Inputs

The ECM accommodates speed bias inputs for both Woodward
and Barber-Colman paralleling devices. It uses these inputs to
adjust the rated engine speed for generating electricity in parallel
with the utility or other generators.

Woodward devices provide the ECM with £3 VDC; Barber-
Colman provides +58 mV centered around 5 VDC. The type of
paralleling device to be used by the ECM, Woodward, Barber-
Colman, or none (disabled), is entered using INSITE™ QST30
G-Drive.

Speed Bias Reference Voltages

The ECM provides two reference voltages for use with external
paralleling devices. A 5 VDC reference voltage is provided for

both Woodward and Barber-Colman digital devices. A 7.75 VDC
reference voltage is provided for use with Barber-Colman analeg
devices.

Spin Box

An entry box with two arrowheads at the right. You can click the
up arrowhead to raise the number in the spin box or click the
down arrowhead to lower the number in the spin box. You can
also type an entry directly in the data entry box.

Stop/Run Switch

This switch instructs the ECM to either stop or run. In the stop
state, the ECM does not command any fueling, and if there are
no active faults or an active diagnostic input, the ECM will power
down.
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The run state alerts the ECM to monitor engine speed. Once
engine (cranking) speed is detected, the ECM opens the fuel
shut-off valves and commands the proper fusiing.

Toolbar

A group of buttons that displays in a column on the left side of the
main INSITE™ QST30 G-Drive window. You click a button to
display its corresponding dialog box.

Torque Curve Adjustment

Adjusts the torque curve percentage for fine tuning the engine
output power to meet the alternator input requirements.

Woodward Scale Factor

Enables the ECM to be adjusted for optimum paralleling
operation when using Woodward paralieling equipment. Also see
Speed Bias Inputs
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Customer Feedback Questionnaire

We appreciate your feedback about our products and services.
Fax your completed questionnaire to us at 812-377-6340 or mail
it to us at:

Cummins Engine Company, Inc.
MC 41317

1460 National Road

Columbus, IN 47201

Customer Feedback
Did We?

Respond guickly?
Respond knowledgeably?
Respond courtecusly?
Solve the problem?

Product Feedback Questionnaire

Product Rating (5=excellent; 1=poor)
Timeliness of delivery 5 4 3 2
Ease of installation

Ease of learning

Usefulness of manual

Overall value

Suggestions or Improvements (please be specific)
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A

Actions column, 24

Add button, 41, 44

Additional Data From ECM button
Snapshot-Sensors, 19

Additional Information dialog box,
23

Adjustable Items, 13, 14, 16

Adjustment Ranges, 14

Adjustments meny, 5, 8, 13, 57

Administrator submenu, 50, 51, 52

Alarm Reset button, 34

Alarm Reset switch, 34, 67

Alarm Reset Switch Input, 39

Alternate Frequency Switch Input,
30

Alternate Frequency Switch Settings,
67

Alternator, 70

Alternator input requirements, 76

Available Parameters, 39, 40, 41, 44

Barber Colman Bias, 39

Barber Colman Scale Facior, 14

Barber-Colman devices, 75

Barber-Colman Scale Factor, 67

Battery Voltage, 3%

Beginning Data Logging Process,
44, 45

Beginning Data Monitoring Process,
39

Cc

Cancel button, 6, 7, 29, 30, 31
Capture button, 41, 43
Change button, 14

Check Box, 67

Check COM port setting, 66

Circuit wiring diagram, 20

Clear button, 41, 45

Close button, 6, 43, 46, 47

COM port, 9, 48, 40

Commanded Value field, 28

Common Alarm, 39

Common Alarm Shutdown Output,
68

Common Shutdown, 28, 68

Common Warning, 28, 39, 68

Communications Messages, 66

Conditions buttons, 23

Control Panel, 33, 35

Coolant Temp, 35

Coolant Temp Tab Dialog, 36

Coolant Temp Warning Threshold,
14, 68

Coolant temperature, 9, 31, 39, 43,
50, 68,71,72,73,75

Coolant temperature fault, 31

Coolant temperature meter display,
35

Coolant Temperature Meter Driver,
39

Coolant Temperature Sensor, 68

Coolant Temperatare Shutdown, 39

Coolant temperatare shutdown
threshold, 71

Coolant Temperature Warning, 40

Coolant temperature warning
threshold, 71

Corresponding Rack Position Sensor
Voltage, 28

Current ECM Time, 18

Customer Feedback Questionnaire,
77

Customer Meter Calibration dialog
box, 35, 36, 37

D

Data Information Line, 3, 7, 68
Data Log Setup dialog box, 46
Data Logger, 43

Data Logging Process, 46
Data Monitoring Process, 42
Datalink connector, 75
Datasets Logged, 46

Default button, 14, 16
Destination File, 45, 46
Destination File name, 41, 43
Diagnostic information, 33
Diagnostic input, 69
Diagnostic mode, 39, 69
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Diagnostic Switch, 40, 69
Diagnostics
engine, 33
Disk space, 46
Display button, 54
Drop Down List Button, 69

E

ECM input, 67, 75

ECM input circuit, 39

ECM meter calibrations, 8

ECM part number, 3, 68

ECM relay driver output, 28

ECM Run Time, 40

ECM Save button, 6, 14, 16, 34, 35,
37,38

ECM software version mumber, 40

ECM time, 18, 26

ECM time of fault, 19

ECM type, 18

Electronic Control Module, 69

Engine coolant temperature, 31

Engine harness, 2, 79

Engine Offset Time, 14, 69

Engine output power, 76

Engine overspeed, 75

Engine Run Time, 40, 69

Engine sensor, 26

Engine sensor data, 17

Engine speed, 35, 40, 69, 70, 71, 72,
74,75,76

Engine Speed Meter Driver, 40

Engine Speed Sensor, 69

Engine’s speed, 34

F

Fault Code, 18, 26

Fault Information command, 17, 18,
29,30, 31,32

Fault Information System, 2, 17, 19,
20, 21, 26, 47

Fault Information-Additional
Information dialog box, 17, 19,
21

Fault Overview Information, 20

Fault Overview window, 17, 20, 21

Fault Simulation, 29, 30, 31

Field Parameter Editor, 13, 16, 30,
31, 35, 36, 37,49

Flywheel ring gear, 6%

Fpe, 16

Fuel pump rack, 27, 70

Fuel Pump Rack Actuators, 70

Fuel Pump Rack Position Sensor,
70, 74

Fuel Pump Rack Test, 27, 49

Fuel Shutoff Valve, 40, 70

Full Reset command, 47

G

Generator Original Equipment
Manufacturer, 71

Generatot set, 67

Glossary buttans, 21, 23

Governor Droop, 14, 34, 71
engine’s, 34

Governor Gain, 34

Governor Gain Adjust, 14

Guided Step Window, 25

Guided Steps, 22

H

HDR file, 41
Help button, 6
Help menu, 4, 9, 53, 54, 55
High Coolant Temp, 31
High Coolant Temperature, 29
High Coolant Temperature
Shutdown, 29, 71
High Coolant Temperature Warning,
28,71
Housing
flywheel, 2, 75
thermostat, 68

Idle Rated Switch Input, 40
Idle Speed, 15, 34, 71
Input Overrides, 34

Jd
Job menu, 5, 8, 11, 12, 57

K
Keyboard button, 6

L

Lamp indicator, 39, 40
Landscape orientation, 12
Last Fault, 18
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Last QOccurrence, 26

Log file, 41, 44, 46

Log file name, 41

Log subdirectory, 45

Logging Data, 43, 44, 45, 46, 47
Low Qil Pressure, 29, 30

Low Oil Pressure Shutdown, 29, 71
Low Oil Pressure Tab Dialog, 30
Low Oil Pressure Warning, 29, 71

Maximum Display Adjustment, 36,
37,38

Maximum Display percentage, 38

Maximum Meter Display, 36, 37

Menu bar, 3, 56, 72

Menu Descriptions, 8

Menu Maps, 56

Meter Calibration, 35, 49

Meter Coolant Temp Max Duty
Cycle, 15,72

Meter Drivers, 72

Meter Engine RPM Max Duty Cycle,
15,72

Meter Maximum Engine RPM, 15,
72

Meter Maximum Oil Pressure, 15, 72

Meter Maximum Temperature, 15,
72

Meter Minimum Engine RPM, 15,
73

Meter Minimum Oil Pressure, 15, 73

Meter Minimum Temperature, 15, 73

Meter Oil Press Max Duty Cycle, 15,
73

Minimum Meter Display, 35, 36, 37

Monitor dialog box, 3%, 41, 42

Monitor Setup dialog box, 39, 41,
42,43

More Fault Info button, 18

More Fault Information dialog box,
20,23

Move Security Key dialog box, 51

NGT computer, 2
Not OK icon, 22, 24, 25

o
Oil Press Warn Threshold, 15, 73

Oil pressure, 9, 30, 35, 36, 40, 50,
72,73,75

engine, 30
0il pressure fault, 30
(il pressure meter display, 36
Oil Pressure Meter Driver, 40
Gil Pressure Sensor, 73
(il Pressure Shutdown, 40
Oil pressure shutdown sensor, 29
Qil Pressure Tab Dialog, 37
Qil Pressure Warning, 40
Oil pressure warning sensor, 29
Oil Pressure Warning Threshold, 71
Overspeed Shutdown, 29, 40, 74
Overspead Shutdown RPM, 15, 74
Overspeed Shutdown threshold, 74
Overspeed Tab Dialog, 32
Overview text, 23

P

Paralleling Scale Factor, 34
Parameter Values, 14

Partial Reset command, 47
Password field, 51

Pause button, 43, 45

Port Number list, 49

Port Setup dialog box, 49

Print button, &

Print Setup command, 11

Print Setup dialog box, 5, 12
Print Topic, 4, 5

Printing Help Topics, 5

Product Feedback Questionnaire, 77
Pulse Width Modulated signal, 70
PWM signal, 70

R

Rack Position, 39
Rack Position Voltages, 74
Radio buttons, 7, 34

Drive B, 51

Rated, 35

Speed Switch, 34
Ramp Time, 13, 15, 74
Rated Speed Override spin box, 32,

34,135,38

Rated speed switches, 34
Real Time, 45
Reference Information, 66
Relay Driver Tests, 28
Relay Drivers, 75
RFM
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engine, 37,72, 73
RPM inciease, 39, 40
RPM meter needle

engine, 72
RPM value, 40
RE232 Datalink, 75
Run Switch, 76
Runtime hours, 69

S

Safety instructions, 23
Sampling Period, 45

Security Information, 52
Security Information Window, 53
Security Install, 51

Security key, 2, 49, 51, 52, 53
Security key diskette, 52, 53
Security Move, 51

Sclected Parameters, 41, 44, 45
Sensor resistance, 68

Serial Number, 53

Set button, 41, 45

Setting COM Port, 9

Setting Options, 9

Shop Talk, 23

Shop Talk buttons, 21
Shutdown Threshold, 30, 31, 32
Sim R, 49

Sim §, 49

Simulated Pressure spin box, 30
Simulated Temperature spin box, 31
Simulator mode, 2, 9, 48, 49
Snapshot Data column, 26
Snapshot dialog box, 17, 26
Solenoid valves, 70

Speed Adjust Input, 40

Speed Adjust Knob, 40, 75
Speed Bias Input Type, 40
Speed Bias Inputs, 67, 75, 76
Speed Bias Reference Voltages, 75
Speed Override, 32, 34, 38
Speed Switch, 34, 35

Start button, 43, 46

Step mumber, 24

Stop Switch Input, 40
Summary Steps, 22

Summary Text, 24, 25
Summary Window, 24
Switches Data, 19

System Menu, 9, 48, 50, 64

T

Tab Dialogs, 29, 35

Table of Ramp Times, 15, 74

Tachometer Calibration, 37

Test Calibration, 36, 37

Tests Menu, 9, 27, 28, 29, 60

Time Elapsed, 46

Tools Menu, 9, 33, 35, 39, 40, 42,
43,44, 45,47, 62

Torque Curve Adjustment, 15, 76

Total Ramp Time

tpm, I5

Troubleshoot engine prablems, 1, 43

Troubleshooting Information, 19, 22

Troubleshooting Steps, 22, 24, 25

u

Units of Measure, 9, 50
User Options command, 48

v

VDC offset voltage, 70

VDC reference voltage, 75

VDC signal, 70

Version Number, 40

View Menu, 8, 17, 29, 30, 31, 32, 58

w

Warning icon, 23

Warning Threshold, 30, 31

Windows 95 close window bution,
29, 30, 31

Woodward Bias, 40

Woodward Scale Factor, 15, 76
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